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UNIT-І 

CONCEPTS OF MS WINDOWS 

1. What is an icon? 

           An icon is a small picture or image representing an application. It means a statue. 

2. How will you change the size of a window? 

 Every window has a border that can be used to change its size.  
 Pointed to the window border by using mouse.  
 The mouse pointer changes into a double headed arrow.  
 This arrow clicked and dragged to increase or decrease the size of window. 

3. How will you change the length and breadth of the window? 

            To change the length and breadth of the window simultaneously, one has to move the 
mouse pointer to either of the bottom corners of the window. Now, the mouse pointer changes 
into a double headed arrow. The arrow clicked and dragged to increase and decrease the length 
and breadth of the window simultaneously. 

4. What is a window? 

 When an application is started, it occupies a rectangular area on the desktop. This 
rectangular area is called a window.  

FEATURES OF MS WINDOWS  

1. What is MS Windows? 

 Operating system is designed and produced by Microsoft Corporation.  
 Similar to other operating systems, Windows make a computer system user 

friendly by providing a graphical display and organizing information so that it 
can be easily accessed. 

 The operating system utilizes icons and tools that simplify the complex 
operations performed by computers. 

2. What are the features of MS-windows? 

 Graphical user interface: It provides a user-friendlier interface to work on. It is more 
powerful, customizable and efficient. Its improved GUI makes learning and using 
windows more natural and easier for all types of users. 
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 Start button: Introduction of the START button is windows made life much simpler 
while there is a need to access multiple programs. 

 Taskbar: As the name suggests, the taskbar provides information and access to the 
entire task that has been currently activated by windows. 

 Shortcuts: A shortcut is a small file that is linked to a program, document, folder or an 
internet address. The file is represented by an icon with an arrow in its lower left corner. 

 Long file names: In order to save a file and retrieve it later, windows gives it an identity 
which is called the filename. 

WINDOW STRUCTURE: 

1. Explain about the structure of window?  

            The window has various elements. The folder is one of the optional desktop folders 
called the User files.  

The window contains the following: 

 Desktop refers to the background of your screen on which the various programs run. 
 Icons are those small pictures on the desktop and inside folders that represents various 

programs and sometimes folders. 
 Folders are containers that can contain icons, programs, data or other folders (sub-

folders). The default folder icon looks like a manila file folder but the look varies with 
different windows versions. 

 The Navigation Pane provides quick links to various folders and locations on your 
computer. 

 The Title Bar refers to the bar at the top of an open window that will tell you what the 
folder/window is and contains minimize, maximize and close buttons. You can also use 
the title bar to move a window around. 

 My Documents contains most of the user documents and files (except for music, pictures 
and videos ). 

 The Address Bar allows you to navigate up and down a series of windows by double 
clicking on a folder. The folder with the Back/Fwd buttons in window would allow you 
to return to the previous folder. 

 Cursor is the graphic which indicates where the mouse is and what sort of action it is 
performing. The cursor will change from the default arrow to various shapes according to 
the purpose it is serving at the time.        

 Task bar refers to the bar usually at the bottom of your window screen with the start 
button on the left and the clock on the right. 

 The scroll bar appears when there is more information in the window than can be 
displayed. This is usually a vertical scroll bar in a display if the width of the window is 
too narrow. 
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DESKTOP 

1. Describe about the desktop? (or) What is desktop?. What are the things you see on the 
desktop. 
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 Windows desktop is very similar to the table top. All the programs in a computer 
are available on the desktop. Here instead of using hand, one can use the mouse 
pointer to point to things and select them. 

 The desktop has several icons. Each icon has a label specifying the name of the 
application it represents. My computer, my documents, my recent documents are 
some of the standard icons that the user can see on the windows desktop. Each of 
these icons represents an application that is frequently used. 

 For example, My computer allows the user to see the contents of the computer, 
install and use new software and hardware. Apart from the standard icons, 
provided by windows, the user can also create icons for the application that are to 
be used frequently and place them on the desktop. 

 Start button: The desktop also contains the taskbar. The taskbar is usually a 
narrow strip, present at the bottom of the screen. On the left, it has the start 
button. When the user clicks on the start button, the start menu appears on the left 
side of the screen. Using the start menu, one can start any application that has 
been currently installed. 

 Quick launch toolbar: Next to the start button is the quick launch toolbar. One 
advantage of using MS windows is the easy access it provides to the internet; 
through the quick launch toolbar which contains icons that allow the user to select 
some commonly used internet-related applications. 

 System tray: On the extreme right is the systems tray that contains the clock and 
icons for other utilities. The empty space between the quick launch toolbar and 
the systems tray is used to display buttons for the applications currently being 
used. 

TASK BAR: 
1. Explain about the Task Bar.  

 The taskbar’s default position is at the bottom of the screen; but it can be repositioned 
to the left, right and top portions of the desktop. 

The Windows taskbar has four main sections:  

 Start Button (labeled with "Start" and the Windows logo)  
 Quick Launch (allowing applications to be launched with a single click) 
 Running Programs (allowing easy access to running programs) 
 Notification Area (contains icons for small running programs such as the clock, 

calendar and volume control) 
 When you start a computer system, then the start button and task bar appears on 

the bottom of the screen and by default remains visible when window is running.  
 Whenever a program is run or a window is opened, an icon representing the 

program appears on the task bar. To switch between windows or program, click 
on the icon representing the window on the task bar. When the program or 
window is closed, the icon disappears from the task bar. 
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 The system tray is part of the task bar and displays a current time as well as the 
status icons. 

 

                                                                                                             | System tray |  

START MENU 

1. Mention the different types of start menu? 

         a) Usual start menu  

        b) Classic start menu. 

2. What is start menu? Describe how it can be accessed? 

 

 The start menu acts as a launch pad for most of the things the user wants to do 
with MS windows. Using this menu, one can start applications, change the 
settings of your computer, find files, get help and much, much more. The start 
menu appears when you click on the start button on the taskbar. 

 One can have two different start menus, one is the usual start menu and another 
one is classic start menu.  
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 One can select an option from this menu by using the mouse. As the user moves a 
mouse pointer over the options, they get highlighted. Simply clicks the mouse 
when the option the user wants is highlighted. 

  All programs on the start menu have an arrow on the right. A right arrow, 
whether the user is in start menu or classic start menu indicates the presence of 
one or more levels of submenu. 

  To select an option on the submenu, the mouse pointer is sided sideways. One 
option on the submenu will get highlighted. Now, the mouse pointer moved up 
and down till the option that the user wants is highlighted and clicked. It is to be 
noted that some of the options in the submenu also have an arrow. Selecting these 
options will display another submenu. 

Overview of the options available in the start menu. 

Task Description 
All programs  Displays a list of installed programs, which a user can start or use. 

My documents Displays a list of documents used by the current user. 
My recent documents Displays a list of recently used documents by the current user. 
My picture Displays a list of pictures/ photos used by the current user. 
My music Displays a list of music/songs used by the current user. 
Control panel Displays a list of utilities to configure the computer system and install 

software and hardware. 
Printers and faxes Displays a list of currently installed printers and faxes in the current 

computer system 
Help and support Start the XP help and support program to find how to do a task in 

windows. 
Search Helps the user to find any file or folder from a list of document used by 

the current user. 
Run  Starts an application program or executes a DOS command 
Log off  Log of the currently logged in user of the system. 
Turn off computer Close currently opened program, log off the current user and switch off 

the computer system.  
 

MY COMPUTER 

1. Define my computer. 

 My computer is one of the icons in desktop. It contains all local drivers and devices 
with removable storage. 

 One way to look for all your files regardless of where they are stored, involves using 
my computer, usually located on the top left corner of the desktop. 
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 Click on the My computer icon. 
 Click on the appropriate drive icon from the My computer window. 
 Click on a folder to display files it contains or other folders. 
 You will notice that a standard windows file icon, is used if the file is not associated 

with a specific application. Examples of files that are associated  with applications and 
therefore have their unique icons to identify them include: word, paint, wordpad. 

MY PICTURES 

1. Define my pictures. 

 My picture is a folder in the MS-windows operating system that is used to store picture 
files. By default, when any picture is created or added to a windows computer, they are 
saved in the my pictures folder. In later versions of windows, my picture is just called 
pictures. 

  Steps to open my pictures: 
1. Click Start.  
2. In the Start Menu, click My Pictures or Pictures. 

 You can add additional folders to the pictures library if want like family pictures or 
family vacations for example. 

 Using windows photo gallery to find pictures:  
One of the simplest ways to locate and view pictures on your computer is by using 
windows photo gallery. By default, photo gallery displays all the pictures and 
videos that are located in the pictures folder and you can add other folders to photo 
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gallery. You can search for pictures and videos by typing in the windows search box 
or by clicking tags, dates or ratings, in the navigation pane. 

 

2. How will you colour your pictures? 

           The colour box contains the colours that one can use. The user can click on the colour of 
his/her choice and use the fill with colour tool, the airbrush or the brush to colour the pictures. 

MY MUSIC: 
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RECYCLE BIN: 

1. What is a Recycle bin? 

        Windows explorer uses a special folder called the recycle bin to hold deleted files. The 
recycle bin is like the garbage can in the house that we empty it once it is full. In the same way, 
one can empty the recycle bin when he/she wants. Using the recycle bin gives the user a chance 
to get back files that have been deleted by mistake. 

2. Explain the recycle Bin. How is it used? 

 Windows explorer uses a special folder called the recycle bin to hold deleted files.  The 
recycle bin is like the garbage can in the house that we empty it once it is full. In the 
same way, one can empty the recycle bin when he/she wants. Using the recycle bin 
gives the user a chance to get back files that have been deleted by mistake.  

 To delete files, first select them. Then right click on the files and the shortcut menu 
appears. On selecting Delete from the shortcut menu and the files will get deleted (in 
reality, they are moved to the recycle bin). One can also drag the selected file/files to 
the recycle bin or to its windows explorer. Being in explorer bar, one can delete 
selected files by just clicking delete the selected items from file and folder tasks. 

 The recycle bin folder is available on the desktop and can be used like any other folder. 
Double clicking on the recycle bin icon opens and the user can check if the deleted files 
are present. If you don’t want to send the deleted items to the recycle bin, Shift + Delete 
key combination will achieve your goal. If you delete some items from floppy or from 



10 
 

CD- RW, the contents will be deleted forever. The contents will not go to the recycle 
bin.  

 To empty the recycle bin, the user may click on the file menu and choose empty recycle 
bin. If the user double clicks the recycle bin, it will open in the explorer bar. One can 
see the explorer bar in the left pane. Contents of the recycle bin are shown in the right 
pane. Under the recycle bin tasks two alternatives are shown. If the user wants to 
restore some item, it is necessary to select them. Then on clicking the restore, all the 
selected items are sent to their former destinations. On clicking the empty recycle bin, 
all the items whether they are selected or not will be eliminated from the computer’s 
storage. Therefore first the user should select those items, which he/she wants to 
recover from the right pane, and click Restore all items. One can then click empty the 
recycle bin. 

 

 

MANAGING FILES AND FOLDERS: 

1. Explain about the file management in windows? 

File management is organized and keeping track of files and folders. It can be done 
through windows explorer or my computer. Windows explorer displays the hierarchical list of 
files, folders and storage drives (both fixed and removable) on your computer. It also lists any 
network drives that have been mapped to as a drive letters on your computer. Windows explorer 
can also be used to copy, move, renames and search for files and folders. 
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For example, to copy a file, you can open a folder that contains the desired file to be 
copied or moved and then just drag and drop the file to target folder or drive. 

 

When files/folders are deleted from hard disk, windows places them in the recycle bin 
from where they can be retrieved until the recycle bin is made empty. Files or folders deleted 
from a removable storage media such as network drive are permanently deleted and are not sent 
to the recycle bin. 

2. How many components does a file name have? What are they?  

 A file name has two components. They are (i) Main component (ii) Extension. 

3. How will you select a folder? 

         To select the folder the user has to just click the folder.  The yellow file icon next to the 
folder changes to look like an open folder. The selected folder is highlighted, and its contents 
displayed in the right pane of the windows explorer. 

4. What are files and folders? 

All information on disks is stored as files. A collection of files is called a folder. 

5. Write a short note on file names. 

         All information in computers is stored in files. Every file has a unique name that helps the 
user to identify it. A file name is made of two components: 
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(i)  Main component  

(ii)  Extension  

 (i) Main component: The first part of the file name is the main component. This part precedes 
the decimal point and is also called the primary name. This is the name given to the file by the 
user. The decimal point separates the main component from the extension. The main component 
can contain alphabets, numbers, spaces and other components like @, $, !, {, }, (, ), [, ]. 
However, there are few characters that a file name cannot contain. They are: /, \, *, ?, ”, <, >. 
Commas and full stops are not included in the set. 

(ii) Extension: This is the second part of the file name. That is, the part that succeeds the 
decimal point is called the extension or secondary name. The extension is used to identify the 
type of file and is normally up to three to four characters long. When a file is created using an 
application, the extension is automatically added to the file’s main component by the application 
itself. Some examples of file extensions are .DOC, .BAS, .XLS and .Java. 

6. Mention the different methods in which you can save a file. 

A file can be saved by:   

(i) By clicking on the file menu and selecting save from drop down list.  
(ii) By clicking on the save icon on the tool bar. 
(iii) By pressing CTRL+S or CTRL+s combinations. 

7. How will you create a new folder?. 

Folders help you to organize your files. You can create a folder either by using my 
computer window or through windows explorer. You can create a folder in any existing disk 
drive or folder on the windows desktop. The steps for creating a folder are: 

 Click on Start, and then click on My Documents. 
 Under File menu click New and select Folder. 
 A new folder is displayed with the default name, New Folder. 
 Type a name for the new folder, and then press ENTER. 
 A new folder can also be created directly on the desktop by right clicking a blank area on 

the desktop, pointing to New, and then clicking Folder. 

EXPLORING HARD DISK: 

CREATING NEW FOLDERS: 

1. How do you create a new folder? 
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 In the left pane, click the drive or folder in which you want to create the new 
folder. 

 Click any free area in the right pane. A context menu will appear. 
 Highlight New. 
 Click Folder. 
 Type a name for the folder. 

2. How will you create a new folder using explorer? 

           Creating new folder using windows explorer is very easy. A new folder can be created 
simply clicking Make a new folder under file and folder task in the explorer bar. It will create a 
new folder in the right pane. One can enter the name that he/she has chosen for the folder in the 
highlighted box and then press the enter key. To create a sub folder, the user must first select the 
folder under which he/she wants to create the new folder. Then by right clicking anywhere in the 
empty space in the right pane of the explorer window a pop-up menu appears. Now the user can 
click on new from the menu shortcut and select folder from the sub menu that appears. One can 
also create a folder from the menu bar by clicking file → new →folder.  

              In the folder bar also one can right click on the empty space on the right pane. Then by 
clicking new in the ensuing shortcut menu then clicking the folder in the sub menu.  

               A new folder with temporary name ‘New folder’ is created.  

             The user can now type the name he wishes to give the new folder and press enter. The 
folder now appears with its new name.      

3. Define briefly about folders. 

 A small yellow icon represents each folder. Note that the disc drives on the computer are 
also treated as folders. 

 A plus sign(+) in the left of the folder icons in the folder bar indicates the presence of 
subfolders within this folder. 

 You can see + or – sign only in the folder bar. 
 You can click on the + sign to display a list of the subfolders. When you do this, the + 

sign changes to the – sign. Clicking on – sign we hide the details. 
 If there is no plus sign to the left of a folder icon, it means that the folders do not have 

any subfolders. 
 A scroll bar in this part of the window allows you to browse through the list of folders. 
 To see the contents of a folder you have to select the folder. 
 To do so just click the folder. The yellow file icon next to the folder changes to look like 

a open folder.  
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 The selected folder is highlighted and its contents are displayed in the right pane of the 
explorer window. 

 The window folders can be selected using mouse and keyboard. 

SEARCHING FILES AND FOLDERS: 

1. How do you search files and folders? 

If you don’t know where a document or folder is located, you can use the search 
option to locate it in the local storage such as hard disk, CD or in the network drive ( if 
the system is a part of a network ). The indexing service provided by the search maintains 
an index of all the files on a computer, making searches faster.  

You can start a search by using the Search box. As you type in a Search box, the 
search looks for matches in the file name, contains and property tags, and displays the 
highlighted results in the Search Results folder. 

          To search for a file or a folder 

 Click start and click on search. 
 Select all files and folders from the left hand side of the windows. 
 Type the name of the file or folder in part or full, or type a word or phrase that 

exists in the file to be searched. 
 If you don’t know either piece of information select one or more of the 

remaining options:  
 In look in, click the drive, folder, or network you want to search. 
 Click on when was it modified? to look for files that were created or 

modified on or between specific dates. 
 To look for files of a specific size, click on what size is it? Select a 

size. 
 Click on more advanced options to specific additional search criteria. 

 Once you finish specifying the search criteria, click on search to 
locate the file.  
Similarly you can search for specific information on internet, or 
people in your address book, search for a printer or a computer on 
your network.   

DISK 

NAVIGATING BETWEEN FOLDERS: 
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1. How do you navigate inside a window? 

 If you can’t see all the information contained in a window, then use the scroll bar at the 
bottom or right edge to view more. You can move the contents displayed in the window 
using the arrows at each end of the scroll bar. 

 For example, clicking on the bottom arrow on the vertical scroll bar will reveal what lies 
below the bottom border of the window. Alternatively you can drag the scroll bar within 
the scroll bar you see hidden areas of the window. 

 If a window is too big or too small for displaying the items it contains, then you can 
resize it. Hold your cursor over a border until it becomes a double arrow. Then drag the 
border to the size you want.   

COPING AND MOVING FILES AND FOLDERS FROM ONE DRIVE TO 
ANOTHER:  

1. What is the difference between copying and moving files? 

        The difference between copying and moving files is that moving removes the files or 
folders from the source location and places them in the destination location. Copying leaves the 
source files or folders untouched and makes a copy in the destination location. 

2. How to copy a file / folder? 

 Right-click the file / folder, you want to copy. A context menu will appear. 
 Click copy. The file / folder should now be on the clipboard. 

3. How to cut a file / folder? 

 Right-click the file / folder, you want to cut. A context menu will appear. 
 Click cut. The file / folder should now be on the clipboard. 

4. How to paste a file/folder? 

 After cutting or copying the file, right- click the object or right- click in the right pane of 
the folder to which you want to paste. A context menu will appear.  

 Click Paste. 

5. How do you copy or move a file/folder using my documents? 

 Click on Start, then click on My Documents. 
 Click the file/folder to be copied. More than one file/folder can be copied at a 

time. 
 To select more than one consecutive files / folders, click the first file / folder, 

press and hold down SHIFT key, and then click the last files / folders. 
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 To select non-consecutive files / folders, press and hold down CTRL key, and 
then click each of the files / folders to be copied. 

 Under Edit menu, select Copy. 
 Select the target drive / folder to which you want to copy the files. 
 Under Edit menu, select paste to copy the desired file/folder to the target drive. 

6. How to delete a file/folder? 

 Right-click the file / folder, you want to delete. A context menu will appear. 
 Click delete. Windows explorer will ask, “Are you sure want to send this object to the 

recycle bin?” 
 Click yes. 

8. How to rename a file/folder? 

 Right-click the file / folder. A context menu will appear. 
 Click Rename. Type the new name. 

WINDOWS ACCESSORIES: 

WINDOWS EXPLORER: 

1. How do you copy or move a file or folder using explorer? 

 Click Start, point to all programs, point to accessories, and then click Windows explorer. 
 Make sure the destination for the file or folder you want to move is visible. 
 Drag the file or folder from the right pane and drop it on to the destination folder in left 

pane to move the folder or file there. 
 If you drag an item while pressing the right mouse button, you can move, copy or create a 

shortcut to the file in its new location. 
 To copy the item instead of moving it, press and hold down CTRL while dragging. 
 If you drag an item to another disk, it is copied, not moved. To move the item, press and 

hold down SHIFT while dragging. 
 Dragging a program to a new location creates a shortcut to that program. To move a 

program, right click and then drag the program to the new location. 
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WINDOWS ACCESSORIES: 

CALCULATOR: 

1. What is a calculator? Give the command to start a calculator? 

           The calculator is a useful application that comes with windows. It can be used to perform 
mathematical and scientific calculations. To start the calculator, the following action is executed, 
Start→ All Programs→ Accessories →Calculator. 

2. Where is the calculator available? How do you use it? Explain briefly. 

               The calculator is a useful application that comes with windows. It can be used to 
perform mathematical and scientific calculations. To start the calculator, the following action is 
executed, Start →All programs →Accessories →Calculator. 

            The calculator can be used in one of the two modes- standard mode or scientific mode. 
Calculator in the standard mode is very similar to the ordinary calculator. One can use the 
keyboard and the mouse to enter numbers and operators. If the user is using the mouse, the 
number and operator buttons are clicked on. The numbers that have been entered and the results 
will be displayed in the display bar just below the menu bar. If the user has selected digit 
grouping under view menu, the number are separated by comma following the European 
convention. The numbers that appear to the left of decimal places are separated by comma for 
every three digits starting from the right. The leading comma (if any ) is suppressed. 
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To use the calculator in the scientific mode, the view menu is clicked on and scientific 
option is selected. To calculate sum, average and S.D of given numbers, the following steps are 
executed: 

(i) First number is entered. 
(ii) Sta button is clicked. 
(iii) RET is clicked. 
(iv)  Dat button is clicked. 
(v) The next number is entered. 
(vi)  Dat button is clicked. 
(vii) Step 5 and step 6 are repeated until all the numbers are exhausted.  
(viii) The s button is clicked. 
(ix)  The standard derivation of the entered numbers is displayed. 
(x) On clicking sum the user will be shown sum of the numbers entered. 
(xi)  On clicking Ave the user will be shown average of the numbers entered. 

On clicking sta button, statistics box will be seen. The entered numbers are in statistics box. 

On clicking the LOAD button of statistics box, the highlighted number in the display area of 
the statistics box will be loaded into display area of calculator display area. 

On clicking CD button of statistics box, the highlighted number in the display area of the 
statistics box will be deleted from the list of numbers. 

On the CAD button of statistics box, all the entered numbers are deleted. 
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NOTEPAD: 

1. Explain about the notepad. 
 Notepad is a simple text editor for MS-windows. It has been included in all versions 

of MS- windows. 
 Notepad is a common text- only editor. The resulting files typically saved with the 

text extension ─ have no format tags or styles, making the program suitable for 
editing system files that are to be used in a DOS environment. 

 Notepad supports both left-to-right and right-to-left based languages, and one can 
alternate between these viewing formats by using the right/left Ctrl+Shift keys to go 
to right-to-left format or left-to-right format respectively. 

 Notepad also has a simple built-in logging function. 
 Each item a file that starts with .LOG is opened, the program inserts a text timestamp 

on the last line of the file. 
 Notepad accepts text from the windows clipboard. 
 When clipboard data with multiple formats is pasted into notepad, the program will 

only accept text in the CF_TEXT format. 
 This is useful for stripping embedded font type and style codes from formatted text, 

such as when coping text from a webpage and casting into an email message or other 
WYSIWYG text editor. 

 The formatted text is temporarily pasted into notepad, and then immediately copied 
again in stripped format to be pasted into the other program. 

 Simple text editors like notepad may be used to edit text with markup, such as  
HTML. 

PAINT: 

1. What is paint? Describe briefly the different parts of paint window. 

            Paint is an application that lets the user to draw and colour pictures. To start paint, the 
user clicks on Start →All programs →Accessories →Paint.  

            The paint window appears on the screen.  



20 
 

 

            Just like any other window, the paint window also has a titlebar with sizing buttons, a 
menu bar and a status bar. In addition, it has a toolbar and a colour box. The tool bar has a 
various tools that one can use to draw and colour.  

             To use any of the tools in the toolbar, first the tool is clicked to select it. For example, 
the ellipse tool is clicked. Then the mouse is moved to the drawing area and it is clicked and 
dragged to draw the figure. 

              The colour box contains the colours that one can use. The user can click on the colour of 
his/her choice and use the fill with colour tool, the airbrush or the brush to colour the pictures. 

              One can close paint by clicking on close button on the titlebar or by clicking on the file 
menu and selecting Exit ( or Alt+F4 keys). 

WORD PAD: 

1. What is word pad? How do you start word pad? 

           Word pad is a simple word processor that comes along with windows. A word processor 
is a program that allows the user to type and store text. To start word pad, the user clicks on            
Start →All programs →Accessories →Word pad. 

      The word pad window appears on the screen. 
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Uses of word pad: 

 Word pad is a MS-windows program that you can use to create documents such as 
letters, notes and posters. 

 It is less complicated than a full word processor but still less you perform a range of 
tasks; create, open and save documents. 

CHARACTER MAP: 

1. Explain about the character map. 

Character map is a utility included with MS windows operating systems and is used to 
view the characters in any installed font, to check what keyboard input( Alt code ) is used to 
enter those characters, and to copy characters to the clipboard in lieu of typing them. The tool is 
usually used for entering special characters. The character map is similar to the insert symbol 
tool in some windows applications such as MS Word. It can be opened via the command line or 
run command dialog using the ‘charmap’ command. 

Other operating systems such as some Unix- Linux variants with GUIs, the HP-48 series 
graphing calculators and others also have a similar accessory. The utility is in Start →All 
Programs → Accessories → System Tools → Character Map. 

In the character map,  
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 Make sure that the Font from the pull down list matches that of the document you are 
creating. If you are doing some other function, such as filling out a web form, select 
times new roman as the font. 

 Look in the grid for the symbol you want. If necessary, use the scroll bars on the right to 
view more characters.  

 If the character you want is not in the grid, change the font to Arial Unicode MS, Lucida 
Sans Unicode, Tahoma, Times New Roman, Arial or some other appropriate font.  

 Double click on any character you wish to insert then click the Select button to make it 
appear in the Characters to Copy field. You can select more than one character at this 
time. 

 Highlight one or more of the characters in the Characters to Copy you wish to insert then 
click the Copy button.  
 

 

Pasting symbol in document, 

 Minimize from the Character Map window, and open or switch to the application window 
in which you wish to insert the character. 

 Position your cursor in the location you wish to insert the character.  
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 Under the Edit menu, choose Paste (or use the keyboard shortcut Ctrl+V). The character 
should appear. 

 If necessary, change the font of the character to the one selected in the Character Map. 

WINDOWS EXPLORER: 

EXPLORING HARD DISK: 

1. How will you explore hard disk?. 

 To enter a hard disk drive with windows explorer means, enter a hard disk drive 
without clicking with your mouse directly. You can enter a hard disk drive with the 
windows explorer option in your computer. 

 Normally you ‘save’ your all computer document in the computer hard disk drive. 
But these computer documents can be damaged by ‘computer virus’ or ‘unauthorized 
software’ from your computer hard disk drive in your computer. 

 Which cannot be used anymore by ‘computer virus’ or ‘unauthorized software’ from 
your computer hard disk drive in your computer. 

 This problem can be ignored by entering your computer hard disk drive with explore 
in your computer. 

COPING AND MOVING FILES AND FOLDER FROM ONE DRIVE TO ANOTHER 
ENTERTAINMENT: 

INSTALLATION OF HARDWARE AND SOFTWARE: 

1. How do you install hardware and software? 

Computer software installation: 

 It is the base program, which is designed to manage the hardware and software resources 
in your computer. 

 Before you install software, the first important step is to check the configuration of your 
computer, and system requirements of the software. 

 Sometimes, the software to be installed is compressed in a RAR or ZIP file.  
 Before installation, you have to uncompress these files and folders. 
 Every computer software come with a ‘Read me’ file. 
 It is advisable to close all other programs and utilities. 
 Software is any set of instructions that tells the hardware what to do. Software is web 

browsers, games and word processors. 
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Computer hardware installation: 

 The computer peripherals are frequently upgraded and many newer and better ones are 
made available each day. 

 You need to first unplug all the power cords of your computer that are connected to the 
mains, before moving on to connecting the hardware. 

 The hardware package may include an accompanying CD that contains the software 
which will help your computer’s OS in recognizing the new hardware. 

 Install this software before you connect the hardware to the computer, which must be 
restarted after a CD installation is complete. 

 Hardware is any part of your computer that has a physical structure. Such as the 
computer, monitor or keyboard. 

 

UNIT-ІІ 

MOUSE OPERATIONS 

1. Define Mouse. 

 Mouse is a device that controls the movement of the cursor or pointer on a display screen. 
A mouse is a small object you can roll along a hard and flat surface. Its name is derived from its 
shape, which looks a bit like a mouse. As you move the mouse, the pointer on the display screen 
moves in the same direction.  

KEYBOARD OPERATIONS 

2. Define Keyboard. 

 The keyboard is very much like a standard typewriter keyboard with a few additional 
keys. The basic QWERTY layout of characters is maintained to make it easy to use the system. 
The additional keys are included to perform certain special functions. These are known as 
function keys that vary in number from keyboard to keyboard. 

3. How do you use the keyboard to move the cursor? (OR) Explain about the keyboard 
operations.  

You can also move the cursor with the help of the keyboard. Sometimes, it is faster to 
move the cursor by using the keyboard shortcut keys. On the right hand side of the keyboard, 
you can find four arrow keys. 

               You can use these keys to move the cursor in the direction of the arrow keys. For 
instance you can use the left arrow (←) key to move the cursor to the previous character 
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position. You can use the right arrow(→) key to move the cursor to the next character position. 
Similarly, you can use up arrow(↑) and down arrow (↓) keys to move the cursor up and down by 
one line, respectively. Word supports a number of other cursors movement commands that can 
help you to move the cursor to the next / previous word or paragraph, beginning/end of the 
line/document, etc. a list of commonly used keyboard shortcuts is given below:             

To move Press key(s) 
One character to the left Left arrow (←) 
One character to the right Right arrow(←) 
To the previous word Ctrl + Left arrow(^←) 
To the next word Ctrl + Right arrow(^→) 
To the end of the line End 
To the beginning  of the line Home 
To the previous line Up arrow(↑) 
To the next line Down arrow(↓) 
To the previous paragraph Ctrl + Up arrow(^↑) 
To the next paragraph Ctrl + Down arrow(^↓) 
Up one screen(scrolling) PgUp 
Down  one screen(scrolling) PgDn 
To the top of the next page Ctrl + PgDn (^PgDn) 
To the top of the previous page Ctrl + PgUp(^PgUp) 
To the end of the document Ctrl + End(^End) 
To the beginning of the document Ctrl + Home (^Home) 
       

MENUS AND COMMANDS 

4. What are the options available in file menu? Explain it. 
File menu is one of the menus in menu bar and it contains the following options; 
 New 
 Open 
 Close 
 Save 
 Save as… 
 Save as HTML… 
 Versions… 
 Page setup… 
 Print preview 
 Print… 
 Send to 
 Properties  
 Exit 
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New:  The new menu is used to open a new document. If we use the keyboard 
combination Ctrl + N, a blank document opens immediately. Selecting the new 
menu item with our cursor gives the opportunity to open a large number of types 
of documents. The shortcut key of the menu is Ctrl + N.  

Open: The open menu is used to open a previously saved document. The shortcut key of 
the menu is Ctrl + O. 

Close: The close menu is used to close the active document but does not quit the 
application. The shortcut key of the menu is Alt + F4. 

Save: The save menu is used to save the active document with its current file name, 
location and format. The shortcut key of the menu is Ctrl + S. 

Save as: The save as menu is used to save by opening a window which gives the 
opportunity to change the file name, location and format. 

Page setup: The page setup menu is used to sets margins, paper size, orientation and other 
layout options. 

Print preview: The print preview menu shows how the file will look when you print it. 

Print: The print menu is used to print the active file, also gives the opportunity to change 
print options. The shortcut key of the menu is Ctrl + P. 

Exit:   The exit menu is used to close the MS-word. 

5. What are the options available in Edit menu? Explain it. 
  Edit menu is one of the menus in menu bar and it contains the following options; 
 Undo cut 
 Repeat cut 
 Cut 
 Copy 
 Paste 
 Paste special 
 Clear 
 Select all 
 Find… 
 Replace… 
 Go to…  

Undo: The Undo cut is used to the actual entry of this item will depend on what you did 
last. For example, if you cut the text, it will be displayed. This selection can be 
repeated several times. The shortcut key of the menu is Ctrl + Z. 
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Repeat: After an action has been undone, it can be reinstated in the document. The 
shortcut key of the menu is Ctrl + Y. 

Cut: The cut menu is used to remove the selection from the active document and place 
it on the clipboard. The shortcut key of the menu is Ctrl + X. 

Copy: The copy menu is used to copy the selection to the clipboard. The shortcut key of 
the menu is Ctrl + C. 

Paste: The paste menu is used to inserts the contents of the clipboard at the insertion 
point (cursor) or whatever is selected. The shortcut key of the menu is Ctrl + V. 

Clear:  The clear menu is used to delete the selected object or text, but does not place it 
on the clipboard. The shortcut key of the menu is Delete. 

Select all: The select all menu is used to select all text and graphics in the active window. 
The shortcut key of the menu is Ctrl + A. 

Find:  The find menu is used to searches for a specified text in the active document. The 
shortcut key of the menu is Ctrl + F.  

Replace: The replace menu is used to searches for and replace the specified text and 
formatting. The shortcut key of the menu is Ctrl + H.               

6. What are the options available in View menu? Explain it. 
View menu is one of the menus in menu bar and it contains the following options; 

 Normal  
 Online layout 
 Page layout 
 Outline  
 Master document 
 Tool bars… 
 Ruler 
 Document map 
 Header and footer 
 Full screen 
 Zoom… 

Normal            : The default document view for most word processing tasks.  

Page layout     : An editing view that displays your document as it will look when printed. 
This view takes more system memory and scrolling may be slow. 
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Tool bars        :  Displays or hides toolbars. The right pointing arrow indicates a list of 
toolbars. To add one slide down to the name of the toolbar and click to 
select. 

Ruler              : Displays or hides horizontal and vertical rulers at the top and left side of 
the document. 

Header and footer: Adds or changes the text that is displayed at the top or bottom of every 
page of the document. 

Full screen     :  Hides most screen elements so you can see more of your document. 

Zoom             :  Controls how large or small, the current document appears on the screen. 

7. What are the options available in Insert menu? Explain it. 

Insert menu is one of the menus in menu bar and it contains the following options; 

 Break… 
 Page numbers… 
 Date and time… 
 Auto text 
 Field… 
 Symbol… 
 Comment 
 Foot note… 
 Caption… 
 Cross- reference… 
 Index and tables… 
 Picture 
 Text box 
 File… 
 Object… 
 Book mark… 
 Hyper link… 

Page break           : Use this command to send your cursor to the top of the next page even 
though the text does not extend to the bottom of the previous page. 

Date and time      :  Choose one seventeen formats for displaying date, time or date and time. 

Auto text             : Insert any of several pre-set text lines, or create your own.  

Symbol               : Insert a symbol from each of your symbol fonts, or any standard font  
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                                    which includes symbols. 

Footnote             :     The footnote is used to place a footnote at the bottom of the page or the 
end of the document. 

Picture               : The picture menu is used to insert pictures from clip art or a file. You can 
also insert auto shapes, word art, or a chart. 

Text box(frame) : Use this to place captions near tables or drawings, or to set off text at the  

beginning of a page. Click and draw the box after making this selection. 

File                   :  Insert a saved document into an active document at the cursor. 

Object              :  Insert an object such as clip art, word Art, an equation or much more.  

Hyper link       : Use this hyper link to place a link to any document stored in your 

Computer. You can later open that document by clicking on the link. 

8. What are the options available in format menu? Explain it. 
Format menu is one of the menus in menu bar and it contains the following options;  

 Font… 
 Paragraph… 
 Bullets and numbering… 
 Borders and shading… 
 Columns… 
 Tabs… 
 Drop cap… 
 Change case… 
 Auto format… 
 Style gallery… 
 Style… 
 Background… 
 Insert text box 

Font            : Font menu is used to change font style, size, colour and a large number of other 
features. You can also change the spacing between letters here. 

Paragraph   : Intend the paragraph using either margin or place some chosen amount of space 
before or after the paragraph. 

Bullets and numbering:   
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If you wish to change the bullets it can be done here. Your bullets can be literally 
any symbol you wish them to be. 

Border      : Border menu is used to create borders around blocks of text, or around the entire 
document. On the page border tab, under the art pull down menu you can find a 
huge selection of graphic borders: hearts, stars, planets and much more. 

Drop cap  : It is used to make the first letter of the paragraph or chapter large enough to span 
several lines. 

Style       :       If you prefer not to use the formatting tool bar, documents style can be changed 
here. 

Background: Another task which can be handled in the formatting toolbar. You can choose the 
colour to highlight selected text in your document. 

Change case: It is used to change the case of the highlighted text.  

Bold, Italic, Underline - It is used to bold or italic or underline the selected text. 

Object    : It is used to make changes to any selected object, image, word art, auto shape or 
any other object inserted into the document. 

9. What are the options available in tools menu? Explain it. 
Tools menu is one of the menus in menu bar and it contains the following options; 

 Spelling and grammar… 
 Language 
 Word count… 
 Auto summarize… 
 Auto correct… 
 Look up reference… 
 Track changes 
 Merge documents… 
 Protect document… 
 Mail merge… 
 Envelopes and labels… 
 Letter wizard… 
 Macro 
 Templates and add-ins… 
 Customize… 
 Options… 

Spelling and grammar: Choose either submenu or the same window opens. Questioned 
spelling is in red, grammar in green. 



31 
 

Language or thesaurus: Have you used the word “like” too many times? Highlight the word, 
select thesaurus and get suggestions like similar and analogous. 

Word count:  Select word count and find out how many pages, words, characters, 
paragraphs and lines. 

Auto summarize: MS-Word summarizes the document; it reduces the length of the 
document by keeping the meaning as it is. 

Auto correct: MS-word will automatically correct some things. If this feature is irritating 
to you, come here to change what is corrected.   

Customize: Opens the same window that you get by going to the view menu and 
selecting toolbar/ customize. 

Options: Modify word settings here. Modify print, editing, spelling and other 
options from this sub menu. 

10. What are the options available in window menu? Explain it. 

Window menu is one of the menus in menu bar and it contains the following options; 

 New window 
 Arrange all 
 Split 
 Open document list 

New window    :   It is used to the opens another window with a copy of the active document. 

Arrange all       : It is displays all open files in the window. This makes dragging and 
dropping from one document to another much easier. 

Split                 :  Splits the active window into panes. 

Open document List:  There is no need to drag windows to the side so you can see other 
documents open in word. In the bottom of the windows there is a list of all 
opened documents. The active document has a check mark beside it. 

11. What are the options available in help menu? Explain it. 

Help menu is one of the menus in menu bar and it contains the following options; 

 Microsoft word help 
 Contents and index 
 What’s this?  
 Microsoft on the web 
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 Word perfect help… 
 About Microsoft word 

Microsoft word help: Opens word’s assistant and get a search box to type in word 
displays possible matches for you to read about it. 

Contents and index:  You can see an index of all topics available in word’s help 
documentation. 

Microsoft on the web:   Select a link and a Microsoft help page is opened in your browser. 

About Microsoft word: It shows information of your version and it helps to produce your 
ID number. 

SHORTCUT KEYS 

12. Explain the shortcut keys. 

 There are several shortcut keys in Microsoft word. They are  

 Ctrl + N: Open a new word document quickly. 
 Ctrl + O: Opens a previously saved document. 
 Ctrl + W: Closes the active window, but does not Exit word. 
 Ctrl + S: Saves the active document with its current file name, location and format. 
 Ctrl + P: Prints the active file, also gives the opportunity to change the print options. 
 Alt+F4: Exit-Closes MS-Word. 
 Ctrl + Z: undo the last action. This selection can be repeated several times. 
 Ctrl + Y: Redo- After an action has been undone; it can be reinstated in the document. 
 Ctrl + X: Cut- removes the selection from the active document and places it on the clip 

board. 
 Ctrl + C: Copy-copies the selection to the clip board. 
 Ctrl + V: Paste-inserts the contents of the clipboard at the insertion point (cursor) or 

whatever is selected. 
 Ctrl + A: Select all- Selects all text and graphics in the active window. 
 Ctrl + F: Find- Searches for a specified text in the active document.   
 Ctrl + B: Bold-Formats selected text; make text bold, or remove bold formatting. 
 Ctrl + I: Italic- Formats selected text; make text italic, or remove italic. 
 Ctrl + U: Underline- Formats selected text; make text underlined, or remove underline. 

 
UNIT-III 

MS EXCEL 
1. Define spreadsheet. 
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A spreadsheet is essentially a matrix of rows and columns. Consider a sheet of paper 
on which horizontal and vertical lines are drawn to yield a rectangular grid. The grid 
namely a cell is the result of the intersection of a row with a column. Such a structure is 
called a Spreadsheet. 

A spreadsheet package contains electronic equivalent of a pen, an eraser and large 
sheet of paper with vertical and horizontal lines to give rows and columns. The cursor 
position uniquely shown in dark mode indicates where the pen is currently pointing. We 
can enter text or numbers at any position on the worksheet. We can enter a formula in a 
cell where we want to perform a calculation and results are to be displayed. A poourful 
recalculation facility jumps into action each time we update the cell contents with new 
data.  

MS-Excel is the most poourful spreadsheet package brought by Microsoft. The three 
main components of this package are: 

 Electronic spreadsheet 
 Database management 
 Generation of Charts. 

 
Each workbook provides 3 worksheets with facility to increase the number of 

sheets. Each sheet provides 256 columns and 65536 rows to work with. Though the 
spreadsheet packages were originally designed for accountants, they have become 
popular with almost everyone working with figures. Sales executives, book-keepers, 
officers, students, research scholars, investors bankers etc, almost any one find some 
form of application for it.  
2. How to open Excel.  

Switch on our computer and click on the Start button at the bottom left of the 
screen. Move the mouse pointer to Programs, then across to Microsoft Excel, 
then click on Excel as shown in this screen.  

 
 

3. Explain the part of the Excel a screen. 



34 
 

 
 The formula bar is the place in which we enter the formula(=A3*B5) 

 
 The alphabets A,B… are known as columns 

 
 This is the name of the workbook. (Book1) 

             
 The rows are numbered as 1,2,3… 

                                      
 Sheet1,Sheet2, Sheet3 are known as worksheet tabs 

                        
4. Define the following. 

 Menu bar: The options shown below are called as Menu Bar. 

                                                  
 Standard Tool bar: The collection of icons for common operations shown 

below is called as Standard Tool Bar. 

 
 Worksheet tabs: Sheet1,Sheet2, Sheet3 are known as worksheet tabs. 
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5. Explain the Toolbar and their icons. 
There are many icons in the toolbar. They are  
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6. How to use Help Menu? 

Click on Help, Contents and Index, then click on the Index tab. The following 
screen will appear. 

                                 
Then type the first few letters to see the help entries for those letters. We can get the 
printout of any help topic by selecting it, right clicking and then clicking Print Topic. 
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7. Explain about the Workbook Management. 
 Task 1: Creating a new workbook: 
Click on File menu and then click on New. 

            
Click Workbook and then click OK button. We will get the screen as shown 

below. 

               
Enter data as shown in the figure below. 
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 Task 2: Saving Workbook 
                          Click on File menu and then click save. We will get the below Screen. 

                              
In the File name text box, type sample and then click Save Button. 

 
 Task 3: Opening an existing workbook. 

Click on the File menu and click on Open. The open dialog box will appear. 

                       
Click on some file (Example: sample.xls), then click on Open. 
 Task 4: Closing our workbook 

Click on File menu, then click Close to close our workbook. 
8. Explain about the cursor management. 

 Task 1: Moving around the worksheet 
 Open sample.xls workbook. 
 Move the cursor in our worksheet by using the arrow keys on the right-

hand side of the keyboard. 
 When we have got lots of rows of data we can move the cursor more 

quickly by using the PgUp and PgDn keys to move up and down a screen 
at a time. 
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 To move one screen to the right, press the Alt key and PgDn keys 
together. 

 To move one screen to the left, press the Alt and PgUp keys together. 
 To move further to the right, just keep pressing the right arrow key 
 To move back to cell A1, press the Ctrl and Home keys together. 
 Pressing the Home key on its own takes we back to column A 
 To move to the last column (XFD) press the Ctrl and right arrow keys 

together. 
 To move to last cell containing data, press Ctrl and End keys together. 
 To move to the last row (1048576), press Ctrl and the down arrow keys 

together. 
 We can also move the cursor with the mouse. Move the mouse pointer to 

the location we want. Press and release the left mouse button once when 
the cursor is where we want it. 

 Task 2: Moving to a Specified cell 
 Click on the Edit menu, choose Go To. We will get the below screen 

 
 Enter the destination cell reference in the Reference text box. 
 Click OK to move directly to the specified cell. 

9. Explain about the data manipulation. 
 Task 1: Entering data 

 Start Excel. Click File and then New. An empty worksheet appears as 
shown below: 

                     
 

 Type Expenditure in cell A1 then press down arrow key to move to cell 
A2. 

 Type Month then press the down arrow key to move to cell A3 
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 Continue to type the data. The resulting worksheet should appear like the 
following screen. 

                          
 

 Save our work by clicking File and then Save As. This dialog box 
appears. 

                      
 Type cash in the File Name text box and then click Save button. Excel 

automatically adds the extension .xls to our file name. 
 Task 2: Editing data 

 Click File and then click Open. 
 Click cash.xls and then click Open. 
 Move the mouse pointer to cell D4, click and release. The cell is 

highlighted and 18 appear in the formula bar. 
 Move the mouse pointer to the formula bar and click once to the right 

of 18. 
 Use the Backspace key to delete 8,then type 4 and press Enter. Cell 

D4 now contains the value 14. 
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 Task 3: Replacing cell data 

 Make the cell B5 active by clicking on it. 
 Type 200 and press Enter. The cell B5 will now contain the value 200 

replacing old value (150). 
 Task 4: Deleting cell contents 

 Move to cell C5 and click to select. 
 Press the Delete key. 
 The cell becomes blank. 
 Drop down the Edit menu and click Undo to reinstate the 145. Excel 

allows 16 levels of undo. We can use Undo and Redo buttons also. 
 Task 5: Copying data 

 Open the cash spreadsheet. 
 Select the cells D3 to D5 
 Click Edit menu and then click Copy. 
 Select the cells F3 to F5. 
 Click Edit menu and then click Paste. 
 Now the cells D3 to D5 are copied into F3 to F5. 

 Task 6: Moving data 
 Open cash.xls spreadsheet. 
 Select the cells from B3 to B5. 
 Click Edit menu and then click Cut. 
 Select the cells G3 to G5. 
 Click Edit menu and then click Paste. 

 Task 7: Data Auto Fill 
 There is an easy method to fill the data in columns and rows. The data 

may be Numeric or dates and text. 
To fill Slno by using auto fill 
 Type Slno for 2 cells (ie.) 1, 2 in the cells A1 and A2 respectively. 
 Select two cells and drag the Fill Handle + 
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 To fill dates in the cells 

 Type date in the cell 
 Select the cell and drag the Fill Handle 

 
 

We can customize the lists with different text data to minimize the redundancy of work. 
Some of the lists are listed below: 

1. Jan, Feb, Mar, Apr, May, June, July…. like months. 
2. Sunday, Monday, Tuesday, Wednesday, Thursday…Like week days. 
3. Adilabad, Anatapur, Chittor, Cuddapah… like District names. 
4. Ravi, Kiran, Praveen, Rama…. like employees list. 

To create a customized list follow the steps given below: 
 Click Tools Menu,Click Options then click Custom Lists tab, then we will 

find the figure given below: 

          
 Click NEW LIST and enter the list in the List entries window 
 Click Add button then click OK button then our list will be added to the Custom 

Lists. That list we can use as and when required to type. 
 Now we can Drag the fill handle (+ ) to get the list automatically. 
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10. Explain about the using formulae and functions. 
 Task 1: Entering a formulae 

 Click File and then click New. 
 Enter the data in the new worksheet as shown below 

                      
 Cell B6 should contain formula. Move the cell pointer to cell B6. 
 Type =B3+B5(formulae and functions should always begin with = sign) 
 Cell B6 will now contain the value 350 
 Look at cell B6; we will see the result of the formula in the cell B6 rather 

than formula. 
 Now repeat the appropriate formula for cell C6, D6. 
 Save our worksheet as cash3.xls. 

 Task 2: Editing Formulae 
 Move the cursor to the formula bar with the mouse, clicking once. 
 Make the desired changes. 
 When we have finished editing the formulae, press the Enter key for the 

changes to take effect. (OR) 
 Edit the contents by pressing F2 key on the keyboard 

 Task 3: Displaying and Printing formulae 
 Click Tools menu and then click Options. 
 Click View tab. 
 In Window options check Formulas check box. The below screen appears. 

 
 Click OK button. 
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 To print the worksheet with formulae displayed, click File menu and click 
on Print Preview. If the lowest is satisfactory, click on the Print button. 

 
 Task 4: Using the SUM function 

 Open cash3.xls spreadsheet. 

 
 Suppose if we want the summation of the cells B3 to B5 should appear in 

the cell B6, then first select the cells from B3 to B6. 
 Click the Auto Sum icon on the toolbar. 
 The result of (B3+B4+B5) will appear in the cell B6. 

 Task 4: Copying Formulae 
 Open cash3.xls spreadsheet. 
 If we want to copy the formula in the cell B6 to C6,D6,E6 then first select 

the cell B6. 
 Move the cursor to the lour right corner of the cell B6. The cursor will 

change to + icon. 
 Drag the cursor from B6 to E6 and release left mouse button. 
 We will notice that the cells C6, D6 and E6 are updated immediately as 

shown below. 

                  
 Task 5: Copying formulae using absolute addressing 

 Create the worksheet shown below and save ABS 
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 If we copy the formula in the cell C2 to C3, C4, C5 we will get the 
incorrect 

                                    
 result because the formula will change in the cell (C3)to B3*A10 but the 

value in the A10 is not defined. The reason is that we are copying relative 
address but not absolute address. To use absolute address move to C2 cell. 

 Edit the formula to =B2+($B$2*$A$9) and press Enter key. 
 Copy the formula to cells C3 to C5. 

                            
11. Explain about the formatting spreadsheet. 

 Task1: Increasing column width 
 Open an existing worksheet(For example cash3.xls) 
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 Move the mouse pointer to the position(column B)shown below in the 

column header. When the black cross appears, hold down the left button 
and drag the mouse to the right to increase the column width by the 
required amount. 

                          
 Task 2: Decreasing column width 

 Open cash3.xls spreadsheet. 
 Move the mouse pointer to the column B. When the black cross appears, 

hold down the left button and drag the mouse to the left to reduce the cell 
width. 

 Task 3: Changing width of all cells in a spreadsheet 
 Open cash3.xls spreadsheet 
 Select the entire worksheet by clicking the Select All button (to the left of 

A1 cell) at the top left corner of the worksheet. The worksheet changes 
from white to black. 
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 Click Format menu, click Column, then click Width 
 In the column width text box type 20, then click OK button. Our 

worksheet cells should all increase in width. 

 
 We will get the below screen. We will notice that widths of all columns 

are now changes to 20. 

                                  
 Click the Undo button to revert to the previous cell width. 

 Task 3: Inserting Columns 
 Open cash.xls spreadsheet. 
 Move to cell B2 and click. 
 Click Insert menu, click Columns. We will get the below screen. 
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 A blank column will be inserted before(to the left of   column B) 

 Task 4: Deleting Column contents 
 Open cash.xls spreadsheet. 
 Move the mouse pointer to column E header and click to select column E. 

                                       
 Press Delete button. The column contents will be deleted. 
 Click Undo button to revert to the previous screen. 

 Task 5: Removing columns, rows, and cells completely 
 Select individual columns or rows or cells. 
 Click Edit menu and click Delete 

 Task 6: Inserting a row 
 When we insert a row, it is inserted above the current row, so if we want 

to insert a new row above row 6(between rows 5 and 6), place the cursor 
on a cell in row 6 and 

 Click on the Insert menu. 
 Click Entire Rows insert a blank row between rows 5 and 6. 

 Task 7: Deleting row contents 
 Open cash.xls spreadsheet. 
 Move the mouse pointer to row 2 header and click to select the row as 

shown below 
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 Press Delete to remove the contents of row. 
 Click the Undo button to cancel the delete operation. 

 Task 7: Inserting cells 
 Open cash.xls spreadsheet. 
 Select cells B2 to D4 by moving the mouse pointer to cell B2, holding 

down the left mouse button and dragging the mouse pointer to cell D4, 
then releasing the left button. The cells should be highlighted. 

                                         
 Click Insert menu and click Cells. This dialog box appears. 
 Click OK to shift the cell down. 

                                         
 Task 8: Changing data justification 

 Open cash.xls spreadsheet. 
 Select the cell B2 as shown below. 
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 Here the text “Jan” by default left justified. We can modify alignment as 
right justified or center by clicking right justify  or center the text 
within the cell by clicking respectively. 

 Task 9: Merge and Center data 
 Open cash.xls spreadsheet. 
 Select the cells A1 to H1 as shown below 

                                      
 Click Merge and Center button on the toolbar 
 We will get the below screen. 

                                      
 Task 10: Formatting cells 

                         
 Create a new spreadsheet as shown below and save it as “marks.xls” 
 Now we can format the cells in column C by selecting column C by clicking 

on the column heading 
 Click Format menu and click on Cells. Click on Number. 
 Use the Down arrow in the Decimal Places to set to 0. Click OK. 
 Now repeat the formatting but this time format the cells to two decimal places. 
 Again, repeating the formatting operation, but this time to four decimal places. 
 Finally, format the cells to eight decimal places. This screen will appear. 
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 The #### symbols indicate that the cell is too narrow to display the data in the 
chosen format. However, if we increase the cell width sufficiently, the data 
will be displayed to eight decimal places. 

 Increase the width column C until the data is displayed. 
 Now change the formatting back to two decimal places, and reduce the 

column width to a suitable width. 
12. Explain about the changing the data Orientation (Vertical, Horizontal etc.) 

 Excel offers three options that let we control the orientation of the text within 
a cell. These are Text alignment, Text orientation, and Text control. 

 
Vertical text alignment can be any one of the following 

 

                                                           
To display text vertically in a cell: 

 Choose Cells from the Format menu. 
 Click the Alignment Tab. 
 Specify the desired text orientation by selecting one of the orientation 

boxes. 
 Select the Wrap text check box, if we want Excel to wrap the text 
 Click OK 

Here are some examples of the different alignment options 
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 Select vertical list box and select top to align the data at the top of the 

cell (Eg: cell A1) 
 The below figure shows we different Text control options.  

 
 

13. Explain about printing and layout 
 Task 1: Previewing a printout 

 Open cash.xls spreadsheet. 
 Click on the File menu and click on Print Preview. A screen similar to this 

should appear. 

                             
 Since the size of the text is very small, we can click on Zoom button, it 

magnifies the worksheet. Clicking on Zoom second time returns to the 
original preview format. 

 Press PgDn to move through our worksheet if it is more than one page 
long. 

 Before printing make sure that our printer is switched on, is loaded with 
the appropriate paper, and is on-line. 

 If we are happy with the layout of our document, click on the Print button 
to obtain a printout. We should see a message on screen telling that our 

file is being printer, and on which paper. 
 Task 2: Printing landscape 
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 To select landscape mode, click on the File menu, Page Setup this screen 
will appear. 

 Click on the Landscape button. 

                                             
 Task 3: Fitting our worksheet to one page 

 In the above screen click on the Fit To: box and type: 1 page wide by 1 
page tall. 

 If we need to make changes to our worksheet before printing, click on the 
Close button to return to our workbook. 

 Task 4: Adjusting margins 
 In the Page Setup dialog box, click the Margins tab and enter the appropriate 

sizes(in inches or centimeters) 
 Task 5: Setting Header/Footer to our worksheet 

 From the Page Setup dialog box, click on the Header/Footer tab to display the 
below screen. 

 In the Header box either we select a title from the drop down menu or enter 
our own title. Similarly for Footer box also we can set our own title. 

 Click on OK. 
 

 
 Task 6: Printing selected cells 

 Open cash.xls spreadsheet. 
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 Click on the row 2 button (or any other row containing data) to highlight the 
entire row. 

 Click on File, Print Area, Set Print Area. The preview screen should only 
display the selected cells. (Row 2). 

 If the preview is satisfactory, click the Print button to print out only row 2. 
 Click on File, Print Area, clear Print Area to reset the Print Area. 

14. Explain about the creating charts and graphs. 
 Task 1: Creating a Pie Chart 

 Open cash.xls spreadsheet. 
 Select the cells A1 to G5 as shown below 

                       
 Click on Insert menu and click Chart option. This will start the Office 

Assistant, to guide us through creating chart. 
 Follow the instructions in each step of the Wizard. The Assistant explains 

each step. 
 At step 3, we can specify the Chart title, X-axis title and Y-axis title 

separately. 
 At step 4, click as object in sheet 1, and then click Finish. 
 Our chart is now finished. Save as cash4. Our chart is saved with the 

spreadsheet. This type of chart is known as an embedded chart and is saved 
with its worksheet. 

 Task 2: Creating charts when the data range is not continuous 
 Open cash4.xls 
 If our requirement is create a chart to show expenditure for February, then 

first select cells A2 to A5. 
 Hold down the Ctrl key and, while holding it down, select cells C2 to C5. Our 

screen should be similar to this one. 
 Click on the Chart Wizard and create a column chart. Our screen should look 

similar to this. 
 If our chart doesn’t appear to show any data, we probably included some other 

cells, probably A1 and/or C1. If so, delete our chart and re-select the correct 
range. 

 Task 3: Sizing a chart 
 Open the cash3.xls created earlier. A screen similar to this one should appear. 
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 The small black markers at each corner and mid-way along each side of the 

chart. These indicate that the chart is selected, and are called its selection 
squares. 

 Click on the mid-point marker on the right-hand side, hold down the left 
mouse button and drag the mouse to the right about one inch (3cm), then 
release the mouse. The width of the chart will be increased. 

 Now practice the same operation on the mid-point marker of each of the other 
sides of the chart. 

 Now try the above, but this time on one of the four corner markers. Note that 
when we use these techniques, the whole chart changes in size, but it retains 
its original proportions. 

 Now use the same technique to reduce the size of the chart. 
 Task 4: Deleting Charts 

 Make sure the chart is selected (the small black markers are visible). If not, 
move the mouse pointer into the chart area and click and release the left 
mouse button once. 

 Press Delete to delete the chart. 
 Task 5: Moving charts and graphs 

 Make the chart active. 
 Move the mouse pointer into the chart area. 
 Hold down the left mouse button and drag the chart to the desired position. 

 Task 6: Chart headings and labels 
 While creating charts the step3 asks for Chart heading, labels for X-axis and 

Y-axis. We can define our own labels or click Next button so that the default 
values can be accepted. 



56 
 

 
 For example Chart title is Expenditure, X-axis label is months and Y-axis 

label is Sales. 
 Task 7: Editing chart items 

 Create the chart as shown below and save it as cash4.xls. 

 

                                   
 Click the chart title(Expenditure). Selection markers(small black squares) 

will appear around the selected item. 
 We can move or size the title in the same way that we can move or size a 

chart. Click the title box and drag it up by about one inch (3 cm), then 
release the mouse. 

 We can format the title by selecting it, then right clicking and then 
selecting “Format Chart Title” from the drop down menu. We will get the 
below screen. 
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 We can select font type, font style and font size as shown above 
 Click OK. 

 
 Task 8: Adding text to a chart 

 Open cash3.xls worksheet. 
 Click View menu, click Toolbars, Drawing. 
 Click the Text box icon on the Drawing toolbar. 

 
 Draw a text box inside the chart area as shown below 

 
 Click inside the text box. A flashing text cursor will appear. Now type 

Household Expenditure 
 We can use the same procedure for any other text that we want to appear 

in charts. 
 Task 9: Adding a legend to a chart 

 Create a pie chart as shown below. 

 
 Display the Chart toolbar, by dropping down the view menu and clicking 

Toolbars, Chart. In the above figure the legend is already added. 
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 Click inside the pie chart, then click once on the add or delete legend 
button on the Chart toolbar. The legend will be added if not already 
present and removed if it is currently present. 

 
 We can also add or delete a legend from the Chart, Chart options menu 

 Task 10: Adding gridlines to a chart 
 Open cash3.xls worksheet and change chart type to Column chart. 
 Click Chart, Chart options to display this box. 

 
 Click the Gridlines tab and tick the gridlines boxes required. 

 Task 11: Adding data labels to a chart 
 Open cash3 worksheet and change chart type to pie chart. 
 Drop-down the chart menu and click Chart options. 
 Click on the Data Labels tab. 
 Click on Show label and percent. Our screen should look similar to this. 

 
15. Explain the cell formatting. 

The formatting tool bar contains buttons used to format the appearance of the 
workbook, such as Bold and Italics. 
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16. How to you merging the cells. 

We can merge the cells across which we want the heading, centering it at the same 
time. To merge cells: 

 Select the cells to be merged. 
 Click the merge and centre button from the formatting toolbar. 

 

                 
 
         To unmerge cells: 

 Select the cells to be unmerged. 
 Click the merge and centre button again which will unmerge the cells selected. 

 

Font style Change the font of the selected cell(s) 
Size Change the font size of the selection 
Bold Put the selection in bold face 
Italics Italicize the selection  
Underline Underline the selection 
Alignment Align the current selection to the left (or) center (or) right. 
Merge and centre Combines two selected cells into one new cell that spans the width 

of both and centre the contents of this new cell 
Currency style Change the style in which the currency is displayed 
Percent style Change the style in which the percent is displayed 
Decrease indent Decrease the indent of a cell by approximately one character  
Border Add or alter the style of borders to format a cell 
Fill color Select a color to fill the background of a cell 
Font color Select a color to apply to a selection of text 
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17. Define freeze panes. 

When we want certain rows or columns to remain static on screen while we scroll 
down or across data on a worksheet, we can use freeze panes. 
    Choose view tab select freeze panes. 

 Select the cell below and to the right of the cells we want to freeze. 
 Choose window from the menu bar the click freeze panes. 
 We will see solid lines appear below and to the right of the frozen rows and 

columns. 
Unfreeze panes: 

 Select freeze panes we will see the unfreeze options in the box.     

                               
 
 

 
PowerPoint 

 
1. What is PowerPoint? 

PowerPoint is a tool you can use to communicate your ideas effectively through visual 
aids that look professionally designed yet are easy to make. With PowerPoint, you can create 
slides for your presentation in the output you require: blank and white overheads, color 
overheads, 35mm slides or on-screen electronic slide shows. In addition, you can prepare 
speaker’s notes, print an outline and print audience handouts. All these components in one 
file make up a PowerPoint Presentation. 
2. How to open the PowerPoint. 
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Click the Start Button on the Windows Taskbar and then select Programs and then click on 
Microsoft PowerPoint. You might also find the PowerPoint icon on your MS Office Toolbar. 
The PowerPoint start up as shown below. To begin working with PowerPoint, you will need 
either to open an existing presentation or create a new presentation using one of available 
options. They are 
 Blank Presentation 
 From Design template 
 From Auto Content Wizard 
 From Existing Presentation Photo album. 

 
3. How to creating a New presentation. 

Whether your presentation will be in the form of an electronic slide show, 35mm slides, 
overhead or just paper print-outs, the process of creating a PowerPoint Presentation is 
basically the same. You can start with a template, a design template or a blank presentation. 
To get to these three basics form, there are three options. 
 Blank Presentation 

The blank Presentation template is a design template that uses the default formatting and 
design. It is useful if you want to decide on another design template after working on the 
presentation content or if you want to create your own custom formatting and design form 
scratch. 

To create a new presentation based on the presentation template, select Blank 
Presentation from the PowerPoint startup dialog box and click OK. With PowerPoint already 
running, you can (1) select New from the File menu, click the General tab on the New 
Presentation dialog box, click the Blank Presentation icon and click OK or (2) click the New 
button on the standard toolbar. The New Slide dialog box appears. 
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 Auto content Wizard 
The Auto content wizard is a series of dialog boxes that gets you started with creating a 

new presentation using a template. You’ll start by answering questions about your presentation 
and end up with the readymade slides. To activate this on-line guide from the PowerPoint is 
already running; select New from the File menu. On the New presentation dialog box, click the 
presentation tab, click the icon for Auto content Wizard and click OK. To bypass the Wizard, 
click instead the icon for the template you want and you’ll get the slides directly. 

 
 Design Template 
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This is advised for first-time and new PowerPoint users. After a few presentations on 
your own, you more than likely will always choose this option so as to have complete control 
over your presentation. A design template is a presentation that does not contain any slides 
but includes formatting and design. It is useful for giving your presentations a professional 
and consistent appearance. You can start to make a presentation by selecting a design 
template or you can apply a design template to an existing presentation without changing its 
contents. 

 
Once you have chosen the ‘template’ option, you have 5 more options in New 
Presentation dialog box. 

 General: Gives one the option to begin with a blank template 
 Presentation Designs: Gives PowerPoint templates from which to work,  
 Presentations: A Presentation template is a presentation that contains slides with a 

suggested outline, as well as formatting and design. It is useful if you need assistance 
with content and organization for certain categories of presentations such as : Training: 
Selling a product, Service, or an idea: Communicating Bad News. When you make a new 
presentation using a template, you’ll get a set of ready-made slides. You replace what’s 
on the slides with your ideas, and insert additional slides as necessary. 

 Web pages: Allows one to add web presentations and documents from your local or 
network computers, 

 Office Templates: Contains your favorite PowerPoint templates from Office 95, 97, 
2000 and so on. 

4. Explain Creating Slides. 
When you create a new presentation using a template (including the Blank Presentation 

template), you start with first and then continue to build the presentation by inserting new slides. 
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5. How to inserting New Slides. 

To add a new slide after the current slide in Slide View: 
 Choose New Slide From the Insert menu, or 
 Click the Insert New Slide button on the Standard toolbar 
 This bring up the New Slide dialog box. 

 
 On the New Slide dialog box PowerPoint gives you a set of available slide layouts, called 

Auto layouts, to choose from. An Auto Layout contains placeholders for titles, Text and 
objects such as clip art, graphs or tables that you may want to put on a slide. You are not 
limited only by this option. As you will see later in the handout, anything can be added to 
any slide. To create slide, click an Auto layout icon that matches the layout of the slide 
you want to make; the name of the selected Auto layout appears in the lower right side on 
the dialog box. Then click OK and the new slide appears on the screen. 
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6. How to insert text on slides. (or) Adding Text to Slides. 
You can insert text on slides by selecting an Auto Layout with text placeholders. Text 

placeholders are formatted for titles and bulleted lists. The text formatting, which includes 
the font, alignment and bullets, depends on the design template you selected. 
7. How to add text to a slide in Slide in Slide View. (or) Using Text Placeholders. 

To add text to a slide in Slide in Slide View, simply click on the text placeholders. The 
directions on the placeholder will disappears will disappear, leaving an empty text box with a 
flashing insertion point. Begin typing. Text automatically wraps as you reach the right border 
of the placeholder. When you’re done, click anywhere else on the slide. To edit text, move 
the mouse pointer over the text(note that it becomes an l-beam), click and edit. When making 
a bulleted list, you automatically create the next bulleted item every time you press Enter. To 
create sublevels, click the Demote (indent more) button on the Formatting toolbar. To move 
up a level, click Promote(Indent less). You bulleted list can have up to five levels. 
8. How to add text outside of the text placeholders using the Text Tool. 

You can use the Text Tool on the Drawing toolbar to add text outside of the text 
placeholders. In Slide View, click the Text Tool and move the mouse pointer to the point on 
the slide where you want to insert text. Click to make a label/Caption or drag to make a text 
box that will wrap the words. Then begin typing and, when you’re done, click anywhere else 
on the Slide. 
9. Explain Adding slide Objects 

You can incorporate elements, such as graphics and even sound and video, into your 
slides in one of the ways. 
 Select an Auto Layout containing a placeholder for an object. Some placeholders are for 

specific object such as clip art, graphs, tables, organizational charts or media clips while 
other placeholders are for all type of objects. 

 Select the desired object (Clip Art, Picture, Move, Sound, Microsoft Graph, Microsoft 
Word Table, and Object) from the insert menu. Click on Object…. From insert menu 
brings up the Insert object dialog box which lists all the different types of objects that can 
be embedded in PowerPoint Slides. 

 You create embedded objects using another application while you are working in 
PowerPoint. (This requires that you have the application installed on your machine.) The 
object’s application menu and toolbar appear on the screen and may temporarily replace 
the PowerPoint menu and toolbars. When you’re finished, click anywhere else on the 
slide to return to PowerPoint. To edit embedded objects you created, double-click on the 
object. Again the object’s application menu and toolbar appear. Make the changes and, 
when you’re done, click anywhere also on the slide. 

10. How to insert a Microsoft word table on a slide. 
To inset a Microsoft Word table on a slide: 

 Double-click on a Table Placeholder, 
 Click on the Word Table Button shown here, or 
 Under the Insert menu, choose Picture, then Word table. 
 And specify the number of rows and columns you want. If you click on the Insert 

Microsoft word Table button on the standard toolbar, drag on the cells to select the 
number of rows and columns. The table appears along with Word’s application menu and 
toolbars. Type the table contents and, when you’re finished, click anywhere else on the 
slide. To edit the table, double-click on it and edit the table using Word tools and menus. 
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11. How to add clip art in a slide. 
You can put graphic images from Microsoft ClipArt Gallery on your slides. To add Clip 

Art to a slide: 
 Double-click on Clip Art placeholder. 
 Under the Insert menu, choose Picture, then clip art. 
 Click the Insert Clip Art button on the Standard toolbar. 

             
12. How to insert a Picture in slide 

You can put scanned image or art created from other programs on your PowerPoint slide.  
Select Picture from the Insert menu, choose from Scanner and use the MS office photo editor 
after opening the file from your computer 

        
13. Explain the word art object. 

You can add text with special effects in your slides using Microsoft WordArt. There are 
at least three ways to put word art in your PowerPoint choose object from the insert menu, or 
double-click on an object placeholder. In the Insert Object dialog box, select Create New and 
chose the latest version of Microsoft Word Art from the Object Type list. The WordArt 
dialog box and menus appear. Type the text and click on Update Display. Choose the special 
effects you want from the WordArt toolbar. When you’re done, click anywhere else on the 
slide. 
14. Explain the Different Views. 

You can switch between five views of your presentation; each view gives you a different 
way of looking at and working with your presentation. To toggle between views, choose the 
desired view format from the View menu or click the appropriate button to the left of the 
horizontal scrollbar (shown here to the left). From left to right, the views are Slide View, 
Outline View, Slide Sorter View, Notes Pages View and Slide Show View. 
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 Slide View: 
In Slide View, you can add graphics to your slides as well as type, edit and format text, 

PowerPoint displays the Formatting and Drawing toolbars in addition to the standard toolbar. 
The presentation appears on the screen one slide at a time. The left side of the status bar 
displays the page number of the current slide. To move to other slides, drag the elevator on 
the vertical scroll bar or click the Previous slide or nest slide button below the scrollbar. 

 
 Outline View: 

Working in Outline View is a good way to organize and develop the content of you 
presentation. To insert text, click where you want to add text and type. Bullet and their 
editing are very easy in this view. Creating sub-level along with promotion and demotion text 
can be done here as well. You can also print a copy of you outline. In this view, you see only 
the title and body text of each slide. The drawing toolbar closes and the Outlining toolbar 
opens. This works much like the Microsoft World Outlining toolbar.
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 Slide Sorter View: 
In Slide Sorter View, you can efficiently perform tasks such as reordering slides and 

adding builds, transitions, and slide timings for electronic presentations. You cannot work on 
text and visual elements of individual slides in this view. PowerPoint displays miniature 
versions of each slide. In addition to the standard toolbar, PowerPoint displays the Slide 
Sorter toolbar. 

 
 Notes page View: 

In Notes Pages Views, you can create pages that you can print and use as a guide during 
your presentation. Each page contains an image of the corresponding slide and placeholder 
for your notes. 

 
 Slide Show View: 

You use Slide Show view to deliver you presentation as an on-screen electronic slide 
show or to look at each slide full-screen. Click the mouse button to advance to the next slide. 
If you’ve reached the last slide or press the Esc Key on the keyboard, you return to the 
previous view. 
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15. How to changing the slide layout. 

In Slide View, you can change the arrangement of objects on a slide, move and resize 
placeholders or replace the current layout with a different Auto-Layout. 
16. How to moving and resizing objects. 

To move or resize an object, first click on the object to select it. Eight handles appear 
around the object. Click and drag a handle to change the size and / or shape of the object. 
Click and drag anywhere else on the object to move it. To resize an object by an exact scale 
while maintaining its proportions, select the object and then choose Scale from the Draw 
menu. Enter the scale on the Scale dialog box and click on OK. 
17. Explain the moving and resizing Placeholders. 

To move or resize or placeholder, select the placeholder and click on its dashed border. 
You will get a fuzzy outline around the border with eight resize handles. Click and drag a 
resize handle to change the size and / or shape of the placeholder. Click and drag anywhere 
else on the fuzzy outline to move it. 
18. How to changing the auto layout. 

To restore a slide’s layout after you’ve made changes to it or to change the Auto Layout 
without deleting any text or object you’ve already put on it select Slide Layout from the 
Format menu or click Slide Layout button on the Status bar. Select the Auto Layout from the 
Slide Layout dialog box and click reapply. 
19. How to Making the Presentation You Need. 
 Slide Setup: 

Unless you created the presentation using the Auto Content Wizard and specified 
otherwise, slides are by default up for an on-screen show. To change this, select Page Setup 
from the File menu. On the Slide Setup dialog box, select the output you want from the Slide 
Sized for drop down list. You can also change slide orientation from landscape to portrait, 
and the physical size of your printouts. 
 Arranging the Template: 

To change the prostration’s design template, select Apply Design from the Format menu 
or click the Apply Design Template button on the Standard Toolbar. In the Apply Design 
Template dialog box, select the design template and click Apply. On a typical installation of 
PowerPoint, the design templates are in the presentation Designs folder in 
C:\MSOffice\Templates. You can also use your own design templates or even an existing 
PowerPoint Presentation. 
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 Black & White Slides: 

To display the presentation in black and white, select Black and White from the View 
menu or click the B&W View button on the Standard Toolbar. In Slide view, you’ll see the 
current slide in black and white and a color slide miniature on a small Color View window. 
The B&W View button toggles between the black and white and color views. To hide the 
Color View window, select Slide Miniature from the View menu. 
 Deleting a Slide: 

To delete a slide in Slide View, select Delete Slide from the Edit menu. In Slider Sorter 
View, Select a slide and hit the delete key from your keyboard. 
 Reordering Slides: 

To move a slide, select the slide in Slide Sorter View and click the Cut button on the 
Standard toolbar. This copies the slide to the Clipboard. Then click on the position where you 
want to insert the slide (note the flashing insertion point) and click the Paste button. You can 
also change the order of your slides in Slide Sorter View by clicking on a slide and dragging 
it to the position where you want it to appear. 
 Delivering an On-Screen Show: 

To deliver your presentation as an on-screen electronic slide show, open the presentation 
in PowerPoint; select Slide Show from the View menu. By choosing Setup Show from the 
Slide Show menu you can choose which slides you want to show during the presentation. 
 During the Presentation: 

To move to the next slide, click the mouse button or press ‘N’ on the keyboard. To get a 
menu of available slide show commands, click the right mouse button or this icon that 
appears on the lower left side of the screen. 
 To go directly to a particular slide, select Go To, Slide Navigator from the menu. On the 

Slide Navigator dialog box, select the slide and click Go To. 
 To annotate a slide during a show, select Pen from the menu and the mouse pointer 

toggles to a pen. Click and drag to write or draw on the slide. To return to advancing the 
slides, switch back to the arrow by selecting Arrow from the menu 
You can deliver an on-screen show on a computer that doesn’t have PowerPoint installed 

using the PowerPoint Viewer, freeware that you can distribute with your presentation. You 
can create disks that contain the presentation and PowerPoint Viewer. Select Pack and Go 
from the File menu and the Pack and Go Wizard guides you through the process. 
 Slide Timings: 

When delivering an electronic slide show, you have the option of manually advancing the 
slides or using slide timing. In Slide Sorter View, click the Rehearse Timing button on the 
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slide sorter toolbar and rehearse the delivery of your presentation. The rehearsal window that 
stays on the screen during the slide show keeps track of the time elapsed since a slide 
appeared on screen. At end of the slide show PowerPoint gives you the total time of the 
presentation and the option to record the slide timings. If you record the slide timings, they 
will appear in Slide Sorter View. To manually revise the timing set for a particular slide, 
select it in slide sorter View and click and Slide Transition Button on the Slide Sorter toolbar. 
Then enter a number in the Advance Automatically after box. To use the slide timings during 
a slide show, choose Use Slide Timings on the Slide show dialog box. Transitions are special 
audiovisual effect that occurs when moving from slide to slide during a electronic 
presentation. To add a transition to a selected slide in the Slide Sorter View, click the Slide 
Transition button on the slide Sorter toolbar. From the Transition dialog box, you can choose 
the effect and speed of the transition and a sound to accompany the visual effect. A transition 
icon appears below the slide miniature of a slide with transition. You can preview the 
transition on the miniature by clicking on the icon. If you want the same transition on all your 
slides, choose Select all from the Edit menu and then all the transition. 

 
 Builds: 

You create build slide if you want to show paragraphs on a bulleted list one at a time 
during a slide show. To build the body text of a selected slide, choose an option that appears 
when you select Present Animation from the Slide Show menu. If you select an option other 
than off, during a slide show the list will appear by first level paragraphs with every mouse 
click using the particular effect. For more options, use the drop down menu on the slide 
sorter toolbar labeled Text Preset Animation. On the Animation Settings dialog box, pick a 
build option, a visual and audio effect, and the text color after a build step. In Slide Sorter 
View, build icon appear below the slide miniature of a slide with build but you cannot 
preview it. For more options, do the following: 
 View your slide in slide view 
 Right click on your slide 
 Choose custom animation 
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 Saving Your Presentation: 
To save your presentation, choose Save As from the File menu. In the File Save dialog 

box, type the name you wish to give your presentation in the File name edit box, select the 
folder where you want it saved from the Save in drop down list, and click Save. If you’re 
going to open the presentation in another computer and want to make sure that text displays 
properly, click the Embed True Type check box. 
 Opening a Presentation: 

To begin working with PowerPoint by opening an existing presentation select Open an 
Existing Presentation from the PowerPoint startup dialog box and click OK. If PowerPoint is 
already running, choose Open from the File menu or click the Open button on the Standard 
Toolbar. From the File Open dialog box, select the folder where the files is located in the 
Look in drop down list, select the file from the Name box, and click open. You can open 
several presentations at a time. To switch between open presentations, select the file name 
from the Window menu. 
 Printing: 

To print, choose Print from the File menu. In the Print dialog box, select from the 
PowerPoint drop down list the output your want (slides, handouts, notes pages or outline) and 
click OK. If you’re printing a color presentation on a black and white printer, click the Black 
& White check box to print Black and White View of the presentation. If your slides are 
sized differently from the paper you’re printing on (for example, 35mm or on-screen), click 
the Scale to Fit Paper check box to make the slide images fill the page  

 
 Getting Help: 

 To access online help, select Microsoft PowerPoint Help Topics from the Help menu. 
You can type in a help request in your own words using the Answer wizard as well. And 
don’t be afraid of the paper clip, star, Einstein look-a-like, or whatever may pop up as your 
assistant. To access any of these options, click on the help button on the standard tool bar. 

 
UNIT – V 

MS ACCESS 
 

1. Define MS Access. 
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Microsoft Access is a relational database management system for windows.  
2. Why do you like Ms Access. (or) What are uses of Ms Access. 

Using this package, following tasks can be performed. 
 Organize data into manageable related units 
 Enter, modify and locate data 
 Extract subsets of data based on specific criteria 
 Create custom forms and reports 
 Automate common database tasks 
 Graph database relationships 
 Add clipart to forms and reports 
 Create macros for automating various functions 
 Create database applications, consisting of modules linked through menus, dialog boxes, 

and command buttons. 
 In Access, the term Database refers to a single file that contains a collection of 

information. Each Access Database consists of tables, queries, forms reports, macros and 
modules. 

3. When should you use Access to store data? 
 Databases, like Access, are used to store large quantities of information. 
 The information can be viewed, sorted, manipulated, retrieved, and printed in various 

ways. 
 The database gives you the flexibility to obtain this data in multiple formats. 
 If the information you need to store is vast, interrelated, and you need to retrieve it fast & 

accurately, Access is probably the way to go. 
4. What is data? 

Data is a information. The age of a person, price of potato, number of students in a 
school, pin code of a city, etc. are some examples of data. 
5. What is a database? 

A database is a collection of data which is organized in a manner that can be easily 
retrieved. They consist of fields, records, and files, much like a telephone book.  

6. What is a field? 
A field is a single piece of information (your last name is one field). 

7. What is a record? 
A record is one complete set of fields (your entry in the telephone book is a record).  

8. What is a file? 
A file is a collection of records (the entire telephone book). 

9. Definitions: 
 Database: A database is a collection of related information. 
 Object: An object is a competition in the database such as a table, query, form, or 

macro. 
 Table: A table is a grouping of related data organized in fields (columns) and records 

(rows) on a datasheet. By using a common field in two tables, the data can be combined. 
Many tables can be stored in a single database. 

 Field: A field is a column on a datasheet and defines a data type for a set of values in a 
table. For a mailing list table might include fields for first name, last name, address, city, 
state, zip code, and telephone number. 
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 Record: A record in a row on a datasheet and is a set of values defined by fields. In a 
mailing list table, each record would contain the data for one person as specified by the 
intersecting fields. 

 Design View: Design View provides the tools for creating fields in a table. 
 Datasheet View: Datasheet View allows you to update, edit, and delete information 

from a table. 
10. What is a Relational Database? 

A relational database is a single database spread across multiple tables. Think of a 
database as a file cabinet and each drawer of the file cabinet is a table.  
Example: All of the employee information is kept in the first drawer; all of the vendor 
information is kept in the second drawer; and all of the purchase orders are kept in the third 
drawer. To connect each of these drawers (which is what makes it "relational"), a set piece of 
data from one drawer has to be present in one of the other drawers. For instance, a purchase 
order will have a vendor name, address, & phone number on it, along with the items purchased, 
purchase price, and any discounts. If the vendor name is the "set" piece of data, it is entered in 
the purchase order table, but the address & phone number are retrieved from the vendor table 
instead of having to re-type that information each time it is needed in the purchase order table. 

 
Database Concepts  

11. Define Database window. 
 The Database Window organizes all of the objects in the database. The default tables are 
listing provides links for creating tables and will list all of the tables in the database when they 
have been added. 

12. Write the format of Field Names  
Field names should be meaningful, without spaces or punctuation, such as SNAME 

(surname), FNAME (first name), DOB (date of birth), ADDRESS1 (first line of address), 
TOWN, PCODE, PHONE etc. You cannot have two fields with the same name. 

13. Write the field types used in Access database. 
 Text: Text and whole numbers that aren’t going to be used in calculations(e.g., age, 

phone number) 
 Date/Time: Dates and time 
 Numbers: Decimals and numbers that are going to be used in calculations, e.g. sales 

figures 
 Currency: money 
 Yes/No: True/false logical values, e.g. a “married” field, field could be logical. 
14. Define Field length. 
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Field length has to be fixed, so you need to plan your database structure beforehand 
(although you can alter the length later). 

15. What are the uses of Primary keys? 
Primary keys are used to sort the records to allow fast access. Access encourages you 

choose one field as the primary key field, and then sorts the records on this field. However, only 
one record with the same value is allowed in the primary key field, for example if you choose 
surname for the primary key, you can only have one Smith, Jones etc. For this reason, you 
should always choose a numeric or a counter field for the primary key: do not use surname as the 
primary key field. 

16. What is Design View? 
Design View customizes the fields in the database so that data can be entered. 

 

 
17. What is Datasheet View? 

The datasheet allows you to enter data into the database 
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Manipulating Database 
18. Define tables in access. 

Tables are grids that store information in a database. 
19. What are the ways to create a table in access? 

Access provides three ways to create a table for which there are icons in the Database 
Window. Double-click on the icons to create a table. 
 Create table in Design view: It will allow you to create the fields of the table. This is the 

most common way of creating a table. 
 Create table using wizard: It will step you through the creation of a table. 
 Create table by entering data: It will give you a blank datasheet with unlabelled 

columns that looks much like an Excel worksheet. Enter data into the cells and click the 
Save button. You will be prompted to add a primary key field. 

20. How to rename a field title? 
To rename, select Format|Rename Column from the menu bar or highlight the column, 

right click on it with the mouse, and select Rename Column from the shortcut menu. 
21. How do you Creating a Database Structure?  

Starting MS-Access 
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 Switch on your computer and then click Start         Programs         Microsoft(MS) Access. 
You will get the following screen. 
 

 
 
 Click on Create a New Database Using Blank Database and click OK button. 

 
 
 Type Employee in the name box as shown in this screen Click Create button. 
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 Click Create button and your will get the following screen. 

 

 
 
 By default Tables tab is selected. You can select other tabs (Queries, Forms, Reports, 

Macros or Modules).  
 

22. How to creating a new table using datasheet view: 
 Click New button. You will get a screen similar to this. 
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 You are now going to create a database table with the following fields and enter some 

records into the database: 
Field Names are Surname, DOB, phone, married, salary, service. 
 

 
 
 Enter records into the table and save by click save button and type the tablename as staff. 
 Click File menu and then click Close to close the Employee database. 

 
23. How to creating a new table using design view. 

 Design View will allow you to define the fields in the table before adding any data to the 
datasheet. The window is divided into two parts: a top pane for entering the field name, data 
type, and an option description of the field, and a bottom pane for specifying field properties. 
 Click Design View and then click OK button. 

The following screen appears: 
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 In the first row of the Field Name box type Surname then press tab once. The screen 

should look like this. 
 

 
 
 Move the mouse pointer down to the Field Size box. The default size is 50. Change the 

size as 10. 
 Move the mouse pointer to the Required box and click. A down arrow will appear. 

Click on this and click Yes. This stops users from entering a record without filling in the 
surname. 

 Move to the next field, and call it DOB for date of birth. 
 Press tab to move to the Data Type box, click once in the box to display the down arrow, 

then click once on the arrow. Click once on Date/Time. 
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 Move to the third field name, call it phone with data type text and field size 12. 
 The next field is married, field type Yes/No. 
 Now create a field wage of type currency, and a field service of type number, Field Size 

single. We have now finished creating our database table structure. 
 Click on File menu, Save to display this box. 

 

 
 
 Type the name Staff in the Table Name box and click OK. 
 Click File menu and then click Close to close the table structure dialog box. 
 Open Staff table by selecting Staff and clicking the Open button. 
 A data entry screen like this will appear 

 

 
 
 Enter records into the table and save by click save button. 
 Click File menu and then click Close to close the Employee database. 

 
24. How to creating a table using the Table Wizard. 

Microsoft Access is filled with wizards, step-by-step dialog boxes that allow you to 
create objects or fields on a database.  
 The Table Wizard used to easily create a table.  
 It allows you to add fields that are necessary for a particular table.  
 The fields have been configured in the general sense so you can use them in your 

database.  
 You can modify any field that was created using the wizard.  
 To use the Table Wizard, on the main menu, you can click Insert -> Table.  
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 Alternatively, on the Database Window, when in the Tables section, you can click the 
new button.  

 These two actions would display the New Table dialog box from where you would select 
Table Wizard.  

 you can double-click Create Table By Using Wizard  
 In the Table Wizard, the tables are organized in two primary categories: Business and 

Personal. 
 To select one of those categories, you can click its radio button. 
 Each main category is made of various sample tables. 
 To select a sample table, you can click its name in the Sample Tables list. 
 In the middle, the Sample Fields list, the fields associated with the selected sample table 

are displaying. From that list, you can select the desired field(s). 
 Once a field has been selected, it displays in the Fields In My New Table list. 

  

 
 
You can then select a different table to mix fields from as many tables as desired. The 4 

buttons between the Sample Fields list and the Fields In My New Table list allow you to add or 
subtract fields. To help with selection and deselecting, the wizard provides four buttons:  
 

Button Role 

 Used to select one field 

 
Used to select all fields from the 
sample table 

 
Used to deselect one field 
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Used to deselect one field 

 
During field selection, if you select a field, its corresponding name appears in the right 

list. If you select a field of the same name more than once, for example, if you select Address 
twice, the 2nd Address would be called Address1. Sometimes that will be what you want, and 
sometimes it will be by mistake. If then you make a mistake when selecting fields, you can 
double-click the unwanted field in the Fields In My New Table list and that field will be 
removed. 
After making your choices, you can keep the names provided by Microsoft Access into your 
table, or you can rename any field to suit your needs. To rename a field, first select it in the 
Fields In My New Table list. Then, click the Rename Field button. In the Rename Field dialog 
box, type the desired name and click OK: 
 

          
 
If you try providing a name for a field that already exists, you would receive an error:  
 

               
 

25.  What do you mean field properties? 
 Field Properties means select any pertinent properties for the field from the bottom pane. 

26. What are the field properties of database? Explain it. 
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� Field Name - This is the name of the field and should represent the contents of the field such 
as "Name", "Address", "Final Grade", etc. The name cannot exceed 64 characters in length and 
may include spaces. 
� Data Type is the type of value that will be entered into the fields. 
� Text - The default type, text type allows any combination of letters and numbers up to a 
maximum of 255 characters per field record. 
� Memo - A text type that store up to 64,000 characters. 
� Number - Any number can be stored. 
� Date/Time - A date, time, or combination of both. 
� Currency - Monetary values that can be set up to automatically include a dollar sign ($) and 
correct decimal and comma positions. 
� AutoNumber - When a new record is created, Access will automatically assign a unique 
integer to the record in this field. From the General options, select Increment if the numbers 
should be assigned in order or random if any random number should be chosen. Since every 
record in a datasheet must include at least one field that distinguishes it from all others, this is a 
useful data type to use if the existing data will not produce such values. 
� Yes/No - Use this option for True/False, Yes/No, On/Off, or other values that must be only 
one of two. 
� OLE Object - An OLE (Object Linking and Embedding) object is a sound, picture, or other 
object such as a Word document or Excel spreadsheet that is created in another program. Use 
this data type to embed an OLE object or link to the object in the database. 
� Hyperlink - A hyperlink will link to an Internet or Intranet site, or another location in the 
database. The data consists of up to four parts each separated by the pound sign (#): 
DisplayText#Address#SubAddress#ScreenTip. The Address is the only required part of the 
string. Examples: Home Page#http://www.raiunuversity.edu# #c:\My 
Documents\database.mdb#MyTable 
� Description (optional) - Enter a brief description of what the contents of the field are. 
� Field Properties - Select any pertinent properties for the field from the bottom pane. 
 

Opening Database 
27. How to open an existing database? 
 Click File menu and then click Open Database option to open Employee database. 

 

            
 
 Open Staff table by selecting Staff and clicking the Open button. 
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 A data entry screen like this will appear 

              
 
 Enter the following records into the table: 

 
 
 

 Now enter some more records into the table. Click File menu, Close to save your work 
and close the table and database. 

 

        
 

Surname DOB Phone married salary service 
Kumar 08/09/49 7057937 Yes 2500 25 
Mahesh 09/05/74 7067894 No 300 2 
Mohan 07/07/63 7094564 Yes 100 10 
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Modifying database structure 
28. How do you Modifying database structure? 

Follow the following steps to modify Employees database structure. 
 Open Employees database, and then open Staff table. 

 

         
 
 Click on the View menu, click Design View to get this screen.  

 

      
 
Access has two main views:  

Data Sheet View for working with data, and Design View, for creating and changing 
database structures, reports, forms and queries. 
 Click on the Indexed field box to display a drop-down menu; the box to the right explains 

the options. Read this box now. 
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 Double-click the Cancel button in the top left of your screen and then click OK button. 
 

29. How do you Set or Change the primary key? 

 
 

 
30. How to Add a new record in a table? 
 Open Employee database and then open Staff table. 
 Move to last record and then press down arrow key. You will get a blank record. 
 Now you can enter a new record as shown below: 
 Kamal  08-04-79  7658905  Yes  $2000  5 
 Now save the file by clicking File menu and then Save option. 
31. How to Edit an existing record? 
 Open Employee database and then open Staff table. 
 Move the mouse pointer to the record which you want to edit and click. 
 Now change the data as you desire and then save the file. 

Ex: Change the Surname field of 5th record to Kiddy as shown below: 
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32. How to Delete a record? 
 Open Employee database and then open Staff table. 
 Select the record which you want to delete and then press Delete key. You will get the 

following screen. 
 

                        
 
 Click Yes button to delete current record. 

 
33. How to Freeze Columns in Access? 

Similar to freezing panes in Excel, columns on an Access table can be frozen. This is 
helpful if the datasheet has many columns and relevant data would otherwise not appear on 
the screen at the same time. Freeze a column by placing the cursor in any record in the 
column and select Format|Freeze Columns from the menu bar. Select the same option to 
unfreeze a single column or select Format|Unfreeze All Columns.  
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34. How to hide and unhide Columns? 
Columns can also be hidden from view on the datasheet although they will not be 

deleted from the database. To hide a column, place the cursor in any record in the column 
or highlight multiple adjacent columns by clicking and dragging the mouse along the 
column headers, and select Format|Hide Columns from the menu bar. 

To show columns that have been hidden, select Format|Unhide Columns from 
the menu bar. A window displaying all of the fields in the table will be listed with check 
boxes beside each field name. Check the boxes beside all fields that should be visible on 
the data table and click the Close button. 

                                       
 

Displaying and searching for data 
35. How do you Creating a query? 
 Open Employee database. 
 Click Query tab and then click New button. This screen will appear. 

 

                        
 
 Click Design View and then click OK button. This screen will appear. 
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 Click Staff, then click Add button to base the query on the 
 Staff table. 
 Click on Close in the Add Table box. The fields of the Staff table are displayed. 

 

 
 
 Click on Surname, hold the mouse button down and drag the field into the field box like 

in this screen. 
 

 
 
 Repeat for DOB and phone fields, dragging them into the second and third columns. 

When you have finished, click File, Close and click Yes to save changes to query. 
 Name your query as NameQuery as shown below and then click OK button. 

 

 
 
 
 Your query is now saved. Look at the query list box and scroll down until you see the 

Name Query query. 
 Click on Name Query to select it, then click the Open button. This screen will appear. 
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 Your query should display only the contents of Surname, DOB and phone fields. 
 

36. What are the different ways to create a Query? 
 To create a query to use as the basis of a form or report, try the form or report wizards. 

They create the form or report, and if it's based on more than one table, they also create 
its underlying SQL statement. If you want, you can save the SQL statement as a query. 

 To create queries from filters you created using Filter By Form, Filter By Selection, or 
Filter For Input, save the filter as a query.  

 If none of these methods satisfies your needs, you can create the query from scratch in 
query Design view. 

Forms 
37. What is the use of forms in access? 

Forms are used as an alternative way to enter data into a database table. 
Create a form 

38. How do you create a form? 
You can create a form on your own or you can have Microsoft Access create your 

form for you using a Form Wizard. A Form Wizard speeds up the process of creating a form 
because it does all the basic work for you. When you use a Form Wizard, Microsoft Access 
prompts you for information and creates a form based on your answers. Even if you've 
created many forms, you may want to use a Form Wizard to quickly lay out all the controls 
on your form. Then you can switch to Design view to customize your form. 

If you just want to create a simple single-column form, you can use the New Object 
button. 

Create a form using AutoForm 
39. How do you create a form using AutoForm? 

AutoForm creates a form that displays all fields and records in the selected table or query. 
Each field appears on a separate line with a label to its left. 
 In the Database window, click the Tables or Queries tab.  
  Click the table or query you want to base the form on, or open the table or query in any 

view. 
 Click the arrow next to the New Object button on the toolbar, and then click AutoForm. 

Create a form with a wizard 
40. How do you create a form with a wizard? 
 In the Database window, click the Forms tab. 
 Click New. 
 In the New Form dialog box, click the wizard that you want to use. A description of the 

wizard appears in the left side of the dialog box. 
 Click the name of the table or query that includes the data you want to base your form on. 
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 You can specify the record source for the form in the wizard. 
 

 
 Click OK. 
 If you clicked Form Wizard, Chart Wizard, or PivotTable Wizard, follow the 

directions in the wizard dialog boxes. If you clicked AutoForm: Columnar, AutoForm: 
Tabular, or AutoForm: Datasheet, Microsoft Access automatically creates your form. 

 
41. Describe how to create Form by Using Wizard. 

To create a form using the assistance of the wizard, follow these steps: 
 Click the Create form by using wizard option on the database window. 
 From the Tables/Queries drop-down menu, select the table or query whose 

datasheet the form will modify. Then, select the fields that will be included on the 
form by highlighting each one the Available Fields window and clicking the 
single right arrow button > to move the field to the Selected Fields window. To 
move all of the fields to select fields, click the double right arrow button >>. If 
you make a mistake and would like to remove a field or all of the fields from the 
Selected Fields window, click the left arrow < or left double arrow << buttons. 
After the proper fields have been selected, click the Next > button to move on to  
the next screen. 

 

 
 
 On the second screen, select the layout of the form. 
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 Columnar - A single record is displayed at one time with labels and form fields listed 
side-by-side in columns 

 Justified - A single record is displayed with labels and form fields are listed across the 
screen 

 Tabular - Multiple records are listed on the page at a time with fields in columns and 
records in rows 

 Datasheet - Multiple records are displayed in Datasheet View    
Click the Next > button to move on to the next screen.                          

 
 
 Select a visual style for the form from the next set of options and click Next>.  

 

 
 
 On the final screen, name the form in the space provided. Select "Open the form to view 

or enter information" to open the form in Form View or "Modify the form's design" to 
open it in Design View. Click Finish to create the form. 
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42. Describe how to create Form in Design View? 
To create a form from scratch without the wizard, follow these steps: 

 Click the New button on the form database window. 
 Select "Design View" and choose the table or query the form will be associated with the 

form from the drop-down menu. 
 Select View|Toolbox from the menu bar to view the floating toolbar with additional 

options. 
 

 
 
 Add controls to the form by clicking and dragging the field names from the Field List 

floating window. Access creates a text box for the value and label for the field name 
when this action is accomplished. To add controls for all of the fields in the Field List, 
double-click the Field List window's title bar and drag all of the highlighted fields to the 
form. 

 

 
 

43. How do you Add Records Using A Form? 
Input data into the table by filling out the fields of the form. Press the Tab key to move 

from field to field and create a new record by clicking Tab after the last field of the last 
record. A new record can also be created at any time by clicking the New Record button at 
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the bottom of the form window. Records are automatically saved as they are entered so no 
additional manual  saving needs to be executed.  

                         
 

44. How to Edit Forms? 
The follow points may be helpful when modifying forms in Design View. 

 Grid lines - By default, a series of lines and dots underlay the form in Design View so 
form elements can be easily aligned. To toggle this feature on and off select View|Grid 
from the menubar. 

 Snap to Grid - Select Format|Snap to Grid to align form objects with the grid to allow 
easy alignment of form objects or uncheck this feature to allow objects to float freely 
between the grid lines and dots. 

 Resizing Objects - Form objects can be resized by clicking and dragging the handles on 
the edges and corners of the element with the mouse. 

 Change form object type - To easily change the type of form object without having to 
create a new one, right click on the object with the mouse and select Change To and 
select an available object type from the list. 

 Label/object alignment - Each form object and its corresponding label are bounded and 
will move together when either one is moved with the mouse. However, to change the 
position of the object and label in relation to each other (to move the label closer to a text 
box, for example), click and drag the large handle at the top, left corner of the object or 
label. 

 Tab order - Alter the tab order of the objects on the form by selecting View|Tab Order... 
from the menu bar. Click the gray box before the row you would like to change in the tab 
order, drag it to a new location, and release the mouse button. 
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 Form Appearance - Change the background color of the form by clicking the Fill/Back 
Color button on the formatting toolbar and click one of the color swatches on the palette. 
Change the color of individual form objects by highlighting one and selecting a color 
from the Font/Fore Color palette on the formatting toolbar. The font and size, font 
effect, font alignment, border around each object, the border width, and a special effect 
can also be modified using the formatting toolbar: 

 

 
 
 Page Header and Footer - Headers and footers added to a form will only appear when it 

is printed. Access these sections by selecting View|Page Header/Footer on the menu 
bar. Page numbers can also be added to these sections by selecting Insert|Page 
Numbers. A date and time can be added from Insert|Date and Time.... Select 
View|Page Header/Footer again to hide  these sections from view in Design View. 

Reports 
45. Why do you use report? 

Reports will organize and group the information in a table or query and provide a way to 
print the data in a database. 
46. How you create a report using the Wizard? 

 Create a report using Access' wizard by following these steps: 
 Double-click the "Create report by using wizard" option on the Reports Database 

Window. 
 Select the information source for the report by selecting a table or query from the  

Tables/Queries drop-down menu. Then, select the fields that should be displayed in the 
report by transferring them from the Available Fields menu to the Selected Fields 
window using the single right arrow button > to move fields one at a time or the double 
arrow button >> to move all of the fields at once. Click the Next > button to move to the 
next screen. 

 

 
 
 Select fields from the list that the records should be grouped by and click the right arrow 

button > to add those fields to the diagram. Use the Priority buttons to change the order 
of the grouped fields if more than one field is selected. Click Next > to continue. 
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 If the records should be sorted, identify a sort order here. Select the first field that records 

should be sorted by and click the A-Z sort button to choose from ascending or descending 
order. Click Next > to continue. 

 

 
 
 Select a layout and page orientation for the report and click Next >. 

 
 
 Select a color and graphics style for the report and click Next >. 
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 On the final screen, name the report and select to open it in either Print Preview or 

Design View mode. Click the Finish button to create the report. 
 

 
 

47. How you create a report in Design View? 
To create a report from scratch, select Design View from the Reports Database Window. 

 Click the New button on the Reports Database Window. Highlight "Design View" and 
choose the data source of the report from the drop-down menu and click OK. 

  
 

 
 You will be presented with a blank grid with a Field Box and form element toolbar that 

looks similar to the Design View for forms. Design the report in much the same way you 
would create a form. For example, double-click the title bar of the Field Box to add all of 
the fields to the report at once. Then, use the handles on the elements to resize them, 
move them to different locations, and modify the look of the report by using options on 
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the formatting toolbar. Click the Print View button at the top, left corner of the screen to 
preview the report. 

 

    
 

48. How do you Printing Reports? 
Select File|Page Setup to modify the page margins, size, orientation, and column setup. 

After all changes have been made, print the report by selecting File|Print from the menu bar 
or click the Print button on the toolbar. 

Table Relationships 
49. Why do you use table relationships? 

To prevent the duplication of information in a database by repeating fields in more than 
one table, table relationships can be established to link fields of tables together. 
50. How to create relationships between tables? Explain. 

To prevent the duplication of information in a database by repeating fields in more than 
one table, table relationships can be established to link fields of tables together. Follow the 
steps below to set up a relational database: 
 Click the Relationships button on the toolbar. 
 From the Show Table window (click the Show Table button on the toolbar to make it 

appear), double click on the names of the tables you would like to include in the 
relationships. When you have finished adding tables, click Close. 
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 To link fields in two different tables, click and drag a field from one table to the 
corresponding field on the other table and release the mouse button. The Edit 
Relationships window will appear. From this window, select different fields if necessary 
and select an option from Enforce Referential Integrity if necessary. 
These options give Access permission to automatically make changes to referential tables 
if a key record in one of the tables is deleted. Check the Enforce Referential Integrity 
box to ensure that the relationships are valid and that the data is not accidentally deleted 
when data is added, edited, or deleted. Click Create to create the link.  

                    
 A line now connects the two fields in the Relationships window. 

                               
 The datasheet of a relational table will provide expand and collapse indicators to view 

sub datasheets containing matching information from the other table. In the example 
below, the student address database and student grade database were related and the two 
can be shown simultaneously using the expand feature. To expand or collapse all sub 
datasheets at once, select 

Format|Subdatasheet|Expand All or Collapse All from the toolbar. 
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Field Properties 
51. Explain field properties. 

Properties for each field are set from the bottom pane of the Design View 
window. 

 Field Size is used to set the number of characters needed in a text or number field. The 
default field size for the text type is 50 characters. If the records in the field will only 
have two or three characters, you can change the size of the field to save disk space or 
prevent entry errors by limiting the number of characters allowed. Likewise, if the field 
will require more than 50 characters, enter a number up to 255. The field size is set in 
exact characters for Text type, but options are give for numbers: 

 Byte - Positive integers between 1 and 255 
 Integer - Positive and negative integers between -32,768 and 32,768 
 Long Integer (default) - Larger positive and negative integers between -2 billion and 2 

billion. 
 Single - Single-precision floating-point number 
 Double - Double-precision floating-point number 
 Decimal - Allows for Precision and Scale property control 
 Format conforms the data in the field to the same format when it is entered into the 

datasheet.  
 Text and memo format. For text and memo fields, this property has two parts that are 

separated by a semicolon. The first part of the property is used to apply to the field and 
the second applies to empty fields. 

 

   
 
 Number format. Select one of the preset options from the drop down menu or construct 

a custom format using symbols explained below: 
 



102 
 

 
 Date format. In the table below, the value "1/1/01" is entered into the datasheet, and the 

following values are displayed as a result of the different assigned formats. 
 

 
 
 

*********** 
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